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Version information

This manual is intended for use with the

RP Monitor software versions 2, 3 and 4.

Please make sure that you have the cor-

rect version.

This manual (7th edition) is written for RP Monitor versions 2.G0, 3.G0, 4.G0 and

later.

Software License Agreement

Kyushu Rion Corporation (hereafter called Kyushu Rion) grants the right to use the soft-

ware and its accompanying documentation (hereafter called the product), provided that you

(hereafter referred to as the user) agree with all conditions listed below.

(1) Copyright ownership
- Kyushu Rion holds the copyright to the product.

(2) Usage rights limitations
- Kyushu Rion grants the user the right to use the product from the date the product is

delivered. This date is as noted on the delivery slip. If the user violates any of the

conditions of this license, the right to use the product ceases. No refund will be

made in such a case.

(3) Usage rights scope
- Kyushu Rion grants the user the right to use the product on a single computer. The

user may not transfer, sell, or lend the product to any third party.

- The user may make one copy of the program disk for backup purposes.

(4) Product alterations
- The user may not alter the product in part or in whole, for whatever reason.
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(5) Product warranty scope
- Specifications of the product may be changed without notice. For one year after the

user has completed user registration, Kyushu Rion will inform the user if any up-

grade of the product has been released.

- Kyushu Rion does not bear responsibility for any kind of damage that may arise

from the use of the product or the failure of the product to perform any function.

This includes any damage due to equipment or media failure.

(6) Other items
- Other items not explicitly covered herein will be dealt with in accordance to copy-

right laws and other applicable legal provisions.

Kyushu Rion Co., Ltd.
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Instruction Manual Version History
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(major user interface change)

KM memory multi mode added

Read-only multi-point added

KX-28A tube multi-point mode added

Tube multi-point mode (M) added

Multi-point measurement mode (R) plus

added (temperature/humidity compliant)

Processing value file creation

Movement of files more than 180 days old

Measurement data output added

Single/total added

06/02/2000 Number of display channels increased from 6

to 8 for compatibility with KR-12A

KR-12A memory receive mode added

Program file name changed

Old name: K9461.EXE

New name: RP_MON.EXE

Bellows sampler compatibility (cycle purge

possible)

Multi-point measurement mode (R) broadcast

command adopted

Measurement data output changed (8-channel

compatibility)

Paper size changed from B5 to A4

Edition Software version Date Contents

1

2

3

4

5

6

1.00-1.23

2.00

2.50-2.93

3.00-3.43

2.A0-2.E5

3.A0-3.E5

4.A0-4.E5

2.F0-

3.F0-

4.F0-



vi

Instruction Manual Version History

02/06/2003 Automatic list/graph print added

Operation history record option added

Particle counter communication history record

option added

Alarm sound changed to dedicated WAV file

Measurement data output changed again to ac-

commodate KF-02B (10-channel compatibil-

ity)

Map zoom capability added

Comment field with print capability added to

graph and list

Edition Software version Date Contents

7

2.G0-

3.G0-

4.G0-



1

Outline

1. Outline

This software is designed to run under Windows 3.1/95/98. It allows automatic operation

control of process particle counters and particle counters for airborne or liquid-borne par-

ticles. The software provides for data collection, display, filing, and printing of measurement

data. Measurement modes for various types of measurement can be selected.



2

Hardware Requirements

2. Hardware Requirements

(1) Computer
- IBM PC/AT or compatible computer capable of running the Microsoft Windows

3.1/95/98. For multi-point measurements, a Pentium CPU is recommended.

- Free hard disk space must be at least 4 megabytes. In addition, sufficient free space

to store measurement data should be available.

- 3.5 inch floppy disk drive

- RS-232C interface supported by Windows, for connection to particle counter

(2) Windows
- Microsoft Windows 3.1/95/98 or later (the software will also run under Windows

95)

- This software is a 16-bit application developed under Windows 3.1.

- Printer supported by Windows, with dedicated printer driver

(3) RS-232C interface expansion board
- Required if the number of internal serial ports in the computer is not sufficient.

- Expansion board must be supported by Windows, supplied with dedicated driver,

and capable of being used as standard device. If a serial port is recognized by the

Windows Terminal applet (under Accessories), it can be used.

(4) UPS (Uninterruptible Power Supply)
- To prevent the possibility of data loss (or fatal hard disk damage) in the event of a

power failure, be sure to equip the system with a UPS (Uninterruptible Power Sup-

ply) designed for personal computers.
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RP Monitor Setup Procedure

3. RP Monitor Setup Procedure

(1) First set up Windows as follows. For details on Windows setup, please refer to the Win-

dows documentation.

While measurement with RP Monitor is being carried out, no other processes that may

cause a slowdown in the processing speed of the computer should be running. Other-

wise there is a possibility of errors when communicating with particle counters, or

partial loss of measurement data.

- Do not use any screen savers.

- Turn off energy saving or suspend mode.

- Turn off hard disk shutdown.

- Turn off any automatic maintenance tools (such as Scandisk etc.).

(2) Shut down all other applications before running Setup. Otherwise the program may not

be installed correctly.

(3) Insert the RP Monitor disk into the floppy disk drive. This is assumed to be drive A: in

the following explanation.

(4) Select "Run" to run the program SETUP.EXE contained on the floppy disk.

(5) Enter "A:\Setup.exe" on the command line, and press the Enter key.
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RP Monitor Setup Procedure

(6) The RP Monitor setup program will execute.

(7) The program asks which language should be used. Select Japanese or English. The lan-

guage chosen here will be used not only for the installation routine but also for the RP

Monitor program after setup is completed. The language can be changed later. If the

operating system is Japanese Windows, some messages may not be in English even if

English is chosen as the language for RP Monitor.

(8) Enter the location where RP Monitor is to be installed. To accept the displayed location,

click on the [Continue] button. The suggested folder name uses the software version, so

that different versions can be installed in different folders, and existing versions will not

be overwritten.

(9) A folder called \DATA will be automatically created under the folder chosen as installa-

tion target. A Measurement data sample file called SAMPLE.TXT as well as other files

will be copied to this folder.
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RP Monitor Setup Procedure

(10) When installation was completed successfully, a program group called RION Applica-

tion will have been created in the program menu.
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Program Startup and Termination

4. Program Startup and Termination

(1) To start RP Monitor, click on the [START] button and select [Programs], [RION Appli-

cation], and then [RP Monitor Ver xxx]. "xxx" stands for the version number.

(2) Immediately after startup, the RP Monitor display looks as follows.

(3) To shut down RP Monitor, select [File] from the menu bar and then select [Exit].

(4) If a measurement is in progress, the following message is displayed. Terminate the mea-

surement and then shut down the program.
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Program Startup and Termination

Note:
While RP Monitor is running and a measurement is being performed, you should

avoid running other applications on the same computer. Windows is not a multi-task-

ing operating system. If another application carries out a lengthy processing sequence,

operation of RP Monitor may be interrupted, causing communication errors or other

problems. Screen savers and other resident-type applications should also not be used.
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Selecting the Measurement Mode

5. Selecting the Measurement Mode

RP Monitor comprises a large number of measurement modes. To switch between measure-

ment modes, select [Options] from the menu bar and then select [Measuring Mode]. When

the measurement mode is changed, the program will shut down automatically. Restart the

program to use the new mode.

It is not possible to carry out measurement in different modes simultaneously.

Ver 2
The following modes (A to G) can be selected.

A : RS-232C mode

B : Read-only RS-232C mode

C : KR-12A memory receive mode

D : KM memory receive mode

E : Read-only multi (R) from bus line

F : Read-only (R) plus 330 from bus line

G : Read-only from data file mode (LAN)

Ver 3
The following modes (H to L) can also be selected.

H : Multi mode (R)

I : Multi mode (M)

J : KM memory receive multi mode

K : KX-28A tube multi-point mode

L : Manifold multi-point mode (M)

Ver 4
Only the following mode can be selected.

M : Multi mode (R) plus 330 mode
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Selecting the Measurement Mode

Note:
The date and time information maintained by RP Monitor is based on the clock in the

computer. Make sure that the "Date and Time Properties" settings are correct.

Note:
When using Windows 2000, adjust the internal clock of the computer only while RP

Monitor is not running.
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Measurement Methods

6. Measurement Methods

6.1 Measurement Method A: RS-232C Mode

(1) Particle counter connection and setup

[1] Connect the particle counters to the COM ports, as shown below.

[2] When using an RS-232C interface expansion board or USB serial adapter, refer to the

documentation of the board before starting RP Monitor. Make sure that all switches of

the board are set correctly, and that the Windows driver supplied by the manufacturer

of the board is installed correctly. If the board has not been set up correctly, the addi-

tional COM ports will not be shown in the setup window of the RP Monitor.

[3] Particle counter setup

The RS-232C interface settings of the particle counter should be left in the factory

default condition.

- Particle counter KM-07, KM-48 or similar

Data transfer rate: 9600 bps

Parity: none

Number of stop bits: 1

Number of data bits: 8

RS-232C: Normal

- Particle counter other than KM-07

Data transfer rate: 4800 bps

Parity: even

Number of stop bits: 2

Number of data bits: 7

Terminator: <CR><LF>
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Measurement Methods

(2) Measurement parameter settings

[Measure]  →→→→→ [Setup] or F4

Refer to section 7 "Measurement Steps for Each Measurement Method" and set the pa-

rameters for measurement method A.

(3) Measurement start

[Measure] →→→→→ [Start] or F5

Sets the particle counters to the measurement condition and starts measurement.

Note:
- Before starting measurement with the RP Monitor software, the particle counters

must be in the stop condition. If a particle counter is already performing measure-

ment, errors may occur.

- When measurement is started, the particle counters are set to the remote condition,

making the controls on the operation panel inactive. Items that are not controlled by

the RP Monitor software, such as the particle counter display size selection, should

be set before starting measurement.

- The alarm function of the particle counter operates independently of the RP Moni-

tor alarm function.

- If an unrecoverable error (disk full error, etc.) occurs during measurement, the mea-

surement is stopped.

(4) Measurement end

[Measure] →→→→→ [Stop] or F3

After confirmation, measurement with the particle counters is stopped. The processed

measurement values (Min. Ave. Max. Times) are written to the measurement data file.

Toolbar

Toolbar

Toolbar
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Measurement Methods

(5) Measurement with syringe sampler or bellows sampler in RS-232C

mode

Starting from this version, the blank volume (blank suction volume) can be set at the

syringe sampler.

Connection example

Example

2 blank measurements of 10 mL/min are performed with the particle counter, followed by

5 measurements in 10 mL units

[1] Make KZ-30W settings as follows

Sample flow rate = 10 mL/min

Drain flow rate = 50 mL/min

Measurement volume = 10.00 mL (set at syringe sampler)

Blank volume = 1.00 mL (set at syringe sampler)

Measurement repeat count = 1

[2] Time to perform 1 10 mL measurement is calculated

Draw time: (Blank:1 mL+Measurement:10 mL)÷10 mL×60 s = 66 s

Drain time: 10 mL ÷ 50 mL × 60 s = 12 s
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Measurement Methods

[3] Set up RP Monitor as follows.

Sample Time = 60 s (measurement time; match to syringe sampler)

Period = 66 s (draw time) + 12 s (drain time) + 4 s (fixed value)

= 82 s or more  (example: Period = 120)

Dispense Time = 1 (example: 1 blank measurements)

MEAS Times = 5 (example: measurement count 5)

Syringe Mode = ON (Do not send stop command)

Standby Mode = OFF (start measurement immediately)

[4] Measurement example with above settings

Date Time 0.2um 0.3um 0.5um 1um 2um Alarm Error

95-07-01 00:00:00 7259 363 26 6 0 N

95-07-01 00:02:00 7256 332 15 2 0 N

95-07-01 00:04:00 7255 353 18 5 0 N

95-07-01 00:06:00 7314 380 22 3 0 N

95-07-01 00:08:00 7190 337 12 4 0 N

Max 00:06:00 7314 380 26 6 1 M.Times=

Ave :: 7255 353 19 4 0 5
Min 00:08:00 7190 332 12 2 0

Note:
This software application does not control operation of the syringe sampler itself. For

example, if measurement at RP Monitor is stopped while drawing sample fluid, the

syringe sampler will continue with the same setting until the preset amount is drawn,

and then the unit will stop.
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Measurement Methods

6.2 Measurement Method B: Read-Only RS-232C Mode

(1) Particle counter connection and setup

[1] Connect the particle counters to the COM ports, as shown below.

[2] When using an RS-232C interface expansion board or USB serial adapter, refer to the

documentation of the board before starting RP Monitor. Make sure that all switches of

the board are set correctly, and that the RS-232C Windows driver supplied by the

manufacturer of the board is installed correctly. If the board has not been set up cor-

rectly, the additional COM ports will not be shown in the setup window of the RP

Monitor.

[3] Particle counter setup

The RS-232C interface settings of the particle counter should be left in the factory

default condition.

Data transfer rate: 4800 bps

Parity: even

Number of stop bits: 2

Number of data bits: 7

Terminator: <CR><LF>

(2) Measurement parameter setting example

[Measure] →→→→→ [Setup] or F4

Refer to section 7 "Measurement Steps for Each Measurement Method" and set the pa-

rameters for measurement method B.
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Measurement Methods

(3) Measurement start

[Measure] →→→→→ [Start] or F5

Starts measurement with the particle counters.

The sequence [Measure] → [Start] sets RP Monitor to the receive condition, and measure-

ment starts by pressing the Start button of the particle counter.

Note:
- In this mode, the particle counters are not controlled by the RP Monitor software.

The measurement is determined not by the RP Monitor setting but by the setting at

the particle counter.

- If an unrecoverable error (disk full error, etc.) occurs during measurement, the mea-

surement (receive measurement data) is stopped.

(4) Measurement end

[Measure] →→→→→ [Stop] or F3

After confirmation, measurement with the particle counters is stopped. The processed

measurement values (Min. Ave. Max. Times) are written to the measurement data file.

Toolbar

Toolbar
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Measurement Methods

6.3 Measurement Method C: KR-12A Memory Receive Mode

With this mode, a particle counter with a buffer memory (such as the KR-12A) can be used

for measurements in the field, storing measurement data temporarily in the buffer. After

measurement are completed, the particle counter is connected to the computer and measure-

ment data are transferred to the computer.

(1) Preparations

[1] Determine the measurement points by assigning them Label names. The label name

can be up to 10 alphanumeric characters long. Special characters or kanji (Japanese

characters) are not allowed.

[2] Select the sample volume (0.01CF, 0.1CF, 1CF, 1.0L, 10L) for each measurement

point.

Example

Room1_P1 Sample Volume = 0.1 CF

Room1_P2 Sample Volume = 0.1 CF

Room2_P1 Sample Volume = 0.1 CF

Room2_P2 Sample Volume = 0.1 CF

[3] Set the Alarm Size, Alarm Level, and Conversion Factor parameters.
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Measurement Methods

(2) Measurement parameter setting

[Measure] →→→→→ [Setup] or F4

- Select the type of particle counter from the Counter Type list.

- Select the number of the COM port (COM No.) to which the particle counter will be

connected on the computer.

- Enter the drive and folder name (Data Path) for storing the measurement data file.

- Enter the contents of steps [1] to [3] above into the particle counter setup.

Using the following keyboard shortcuts makes the entry process easier (Copy =

[Ctrl] + [C], Cut = [Ctrl] + [X], Paste = [Ctrl] + [V]).

Refer to section 7 "Measurement Steps for Each Measurement Method" and set the pa-

rameters for measurement method C.

(3) KR-12A setup

(1) Make the following settings for the KR-12A.

- Adjust date and time so that they are current.

(Clock Setup Menu)

- Clear all buffer data. (Buffer Count)

- CNT Data can be either Cumulative or Differential.

(The value sent to RP Monitor is Cumulative. To display the Differential value at

RP Monitor, set RP Monitor to Single.)

(2) Input the selected label name at the KR-12A. For information on input procedure,

please refer to the KR-12A documentation. Note that you should use

HHPC6Utility.exe supplied with the KR-12A to set the I/O port of the KR-12A to

Serial 9600  .
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First select the

Counter Type.

This becomes the location number and is used in the file name (00 to 99).
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Measurement Methods

(4) Mobile measurement

Perform measurement in the field as follows.

[1] Set the KR-12A measurement mode to Concentration mode, Totalize mode, or Audio

mode. In any mode, the value sent to the RP monitor is the same as in Totalize mode

(actual data).

[2] Enter the predetermined Label name and Sampling Volume into the KR-12A. If the

Sampling Volume settings are used for all measurement points, no change is required,

but before measurement, the Label name must always be entered.

[3] Perform measurement at each point with the KR-12A.

When a measurement is completed, measurement data are stored automatically in the

buffer memory of the KR-12A.

[4] Measurement can be repeated until the buffer memory of the KR-12A (500 data) be-

comes full.

Other features:

- Sequence of measurement points can be freely changed.

Because data are stored and managed using the Label names, data can be col-

lected in any sequence.

- Measurement count can be freely changed.

Even if the same measurement point is measured repeatedly, data will be man-

aged properly using the date and time information.

- Measurement cycle can be freely changed.

The measurement cycle can be changed, such as switching from daily to weekly

checks.

- Multiple KR-12A units can be managed.

Because the label name is used to manage measurement points, simultaneous

measurement with several KR-12A units is possible provided that there are no

duplicate label names. When receiving data from the same measurement point,

always select the KR-12A with the oldest data first.
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(5) Measurement data receive/store

Connect the KR-12A to the computer as shown below.

- Set KR-12A I/O port to  Serial Type2  (I/O Port).

[1] From the menu, select [Measure] → [Start].

[2] When preparations for communication are complete, click on the [OK] button.

[3] When communication starts, the following display is shown, including the received

string.

After all data have been received, they are automatically stored in a file. The file name

is created automatically.

The file name convention is yy (year) mm (month) KRxx.txt.

Example: 0102KR00.txt

yy : Measurement year (2001)

mm : Measurement month (February)

KR : Fixed(always "KR")

xx : LOC number (LOC = 00)

txt : Text file extension

The TAB code is used as delimiter in the file.

For each LOC number (selected at SETUP window), one file per month is created.
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[4] If a communication error occurs, an error message is displayed. Check the KR-12A

settings, the cable connection, and other possible causes.

When an error has occurred, correctly received data up to that point are stored in the

file.

[5] After data have been sent from the KR-12A, they are automatically cleared from the

buffer memory of the unit. Therefore it is not necessary to clear the data before the

next measurement.

[6] The time required to receive and store 500 data sets from memory is about 4 minutes.

[7] If the Sample Volume setting of the KR-12A used for measurement was not appropri-

ate, an error message will be shown when receiving these data. When you click on

[OK], the data are not stored and the next data can be received. Clicking on [Cancel]

will terminate the receive/store process.

[8] When the data receive process was completed successfully, the following display is

shown.

Note:
Because the data in the buffer memory of the KR-12A will be automatically cleared

after having been transferred to the computer, they can no longer be sent directly to

the printer (DPU-414) from the KR-12A. Reversely, when printing directly from

the KR-12A to the printer, you must clear the buffer contents manually to enable

data transfer to the computer.
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6.4 Measurement Method D: KM Memory Receive Mode

With this mode, a particle counter with a buffer memory (such as the KM-07) can be used for

measurements in the field, storing measurement data temporarily in the buffer. After mea-

surements are completed, the particle counter is connected to the computer and measurement

data are transferred to the computer. This is possible also with other particle counter models

equipped with a buffer (KM-20, KM-27, etc.)

(1) Preparations

[1] Determine the measurement points by assigning them location ("LOC") numbers and

names. The possible range for LOC numbers is 0 to 99. Enter the respective number at

the KM-07 when making the measurement. LOC numbers must be unique; no dupli-

cation is allowed. Measurement point names may be up to 32 alphanumeric characters

long (no special characters).

[2] Set the measurement time (Sample Time) for each measurement point.

Example

LOC = 0 Sample Time (Sec) = 60

LOC = 1 Sample Time (Sec) = 60

LOC = 2 Sample Time (Sec) = 60

LOC = 3 Sample Time (Sec) = 60

[3]  Set the Alarm Size, Alarm Level, and Conversion Factor parameters.

[4]  Set the particle size to measure with the KM-07.

Example

CH1 = 0.3 um CH2 = 0.5 um
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(2) Measurement parameter setting

[Measure] →→→→→ [Setup] or [F4]

- Select the type of particle counter from the Counter Type list.

- Select the number of the COM port (COM No.) to which the particle counter will be

connected on the computer.

- Enter the drive and folder name (Data Path) for storing the measurement data file.

- Enter the contents of steps [1] to [3] above into the particle counter setup.

Using the following keyboard shortcuts makes the entry process easier (Copy =

[Ctrl] + [C], Cut = [Ctrl] + [X], Paste = [Ctrl] + [V]).

- Particle size data are stored for each measurement point at the time when measure-

ment is carried out and data are received.

Refer to section 7 "Measurement Steps for Each Measurement Method" and set the

parameters for measurement method D.

Toolbar

First select the

Counter Type.

This becomes the location number and is used in the file name (00 to 99).
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(3) KM-07 setup

Make the following settings for the KM-07.

- Adjust date and time so that they are current.

- Set interface mode to "Normal".

- Set data transfer rate to 9600 bps.

- Clear all buffer data.

(4) Mobile measurement

Perform measurement in the field as follows.

[1] Set the KM-07 measurement mode to Manual, Auto, or Average.

This can be changed also during measurement.

Manual: When measurement is started, only one measurement is carried out,

using the preset measurement time.

Auto: When measurement is started, a preset number of measurements are

carried out, using the preset measurement time. Instantaneous value

data for all measurements are stored in the buffer.

Average: When measurement is started, a preset number of measurements are

carried out, using the preset measurement time. Using the data from

these measurements, the average value is calculated and stored in the

buffer.

[2] Enter the predetermined LOC number, particle size, and sampling time into the KM-07.

If the same particle size and sampling time settings are used for all measurement

points, no change is required, but before measurement, the LOC number must always

be entered.

[3] Perform measurement at each point with the KM-07.

When a measurement is completed, measurement data are stored automatically in the

buffer memory of the KM-07.

[4] Measurement can be repeated until the buffer memory of the KM-07 (200 data) be-

comes full.
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Other features:

- Sequence of measurement points can be freely changed.

Because data are stored and managed using the LOC number, data can be collected

in any sequence.

- Measurement count can be freely changed.

Even if the same measurement point is measured repeatedly, data will be managed

properly using the date and time information.

- Measurement cycle can be freely changed.

The measurement cycle can be changed, such as switching from daily to weekly

checks.

- Multiple KM-07 units can be managed.

Because measurement points are managed using the LOC numbers, several KM-07

units can be used simultaneously. However, if multiple data were collected for the

same measurement point, be sure to load the older data into the computer first.

(5) Measurement data receive/store

Connect the KM-07 to the computer as shown below.

[1] From the menu, select [Measure] → [Start].

[2] When preparations for communication are complete, click on the [OK] button.

� � � 	

� 
 � � � � � �
� 
 � � � � � 	  � � + + � � 	 � � � 
 � � #

� � � � � � � 	 	
� 
 � � � � � 	 � 


. � � � � � � � � 	 � � � � � 	 � � & � /



25

Measurement Methods

[3] When communication starts, the following display is shown, including the received

string.

After all data have been received, they are automatically stored in a file. The file name

is created automatically.

The file name convention is yy (year) mm (month) KMxx.txt.

Example: 0120KM00.txt

yy: Measurement year (2001)

mm: Measurement month (February)

KM: Fixed (always KM)

xx: LOC number (LOC = 00)

txt: Text file extension

The TAB code is used as delimiter in the file.

For each LOC number, one file per month is created.

[4] If a communication error occurs, an error message is displayed. Check the KM-07

settings, the cable connection, and other possible causes.

When an error has occurred, only the correctly received data up to that point are stored

in the file.

[5] After data have been sent from the KM-07, they are automatically cleared from the

buffer memory of the unit. Therefore it is not necessary to clear the data before the

next measurement.

[6] The time required to receive and store 200 data sets from memory is about 80 seconds.

[7] If the Sample Time setting of the KM-07 used for measurement was not appropriate,

an error message will be shown when receiving these data. When you click on [OK],

the data are not stored and the next data can be received. Clicking on [Cancel] will

terminate the receive/store process.
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[8] If the Particle Size setting of the KM-07 used for measurement was not appropriate,

an error message will be shown when receiving these data. When you click on [Yes],

the data will be stored in a file with a new name. Clicking on [No] will cause the data

to be discarded.

[9] When the data receive process was completed successfully, the following display is

shown.

Note:
Because the data in the buffer memory of the KM-07 will be automatically cleared

after having been transferred to the computer, they can no longer be sent directly to the

printer (CP-10 or similar) from the KM-07. The same also applies if the data are sent

to the printer first. They will be cleared from the buffer and therefore cannot be sent to

the computer.
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6.5 Measurement Method E: Read-Only Multi (R) From Bus Line

(1) Particle counter connection

[1] Connect the existing bus line to the COM port of the computer, using the Converter II,

as shown below. This mode can be used for particle count display at a remote location.

(2) Measurement parameter setting

[Measure] →→→→→ [Setup] or F4

Refer to section 7 "Measurement Steps for Each Measurement Method" and set the pa-

rameters for measurement method E.
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(3) Measurement start

[Measure] →→→→→ [Start] or F5

Starts the process for receiving measurement data from the particle counters.

Note:
- In this mode, measurement data can only be received if the master RP Monitor is

currently carrying out measurement. Control of particle counters by RP Monitor

and control of master RP Monitor is not possible.

- The measurement count may be different from the master RP Monitor. This is due

to different handling of communication errors. (When a D=2 error or similar has

occurred at the master, the slave discards these data as invalid.)

- The Command column of the real-time display shows only "Count n". Other com-

mands such as "LDON" or "Stop" cannot be shown.

- When "Dispens Times", "Ave Times", "MEAS Times" etc. have been set, measure-

ment must be started simultaneously with the master RP Monitor, otherwise results

will be different.

- If an unrecoverable error (disk full error, etc.) occurs during measurement, mea-

surement data receive is stopped.

- Measurement time information is sent at regular intervals from the master RP

monitor for time matching at the slave computer, so that there will be no shift in

measurement time.

(4) Measurement end

[Measure] →→→→→ [Stop] or F3

After confirmation, measurement data receive of RP Monitor stops. The processed mea-

surement values (Min. Ave. Max. Times) are written to the measurement data file.

Toolbar

Toolbar
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6.6 Measurement Method F: Read-Only Multi (R) Plus 330 From

Bus Line

(1) Particle counter connection

[1] Connect the existing bus lines to the COM ports of the computer, using two Converter

II units, as shown below.

(2) Measurement parameter setting

[Measure] →→→→→ [Setup] or F4

Refer to section 7 "Measurement Steps for Each Measurement Method" and set the pa-

rameters for measurement method F.
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(3) Measurement start

[Measure] →→→→→ [Start] or F5

Starts the process for receiving measurement data from the particle counters.

- In this mode, measurement data can only be received if the master RP Monitor is

currently carrying out measurement. Control of particle counters by RP Monitor

and control of master RP Monitor is not possible.

- The measurement count may be different from the master RP Monitor. This is due

to different handling of communication errors. (When a D=2 error or similar has

occurred at the master, the slave discards these data as invalid.)

- The Command column of the real-time display shows only "Count n". Other com-

mands such as "LDON" or "Stop" cannot be shown.

- When "Dispens Times", "Ave Times", "MEAS Times" etc. have been set, measure-

ment must be started simultaneously with the master RP Monitor, otherwise results

will be different.

- If an unrecoverable error (disk full error, etc.) occurs during measurement, mea-

surement data receive is stopped.

- Measurement time information is sent at regular intervals from the master RP

monitor for time matching at the slave computer, so that there will be no shift in

measurement time.

(4) Measurement end

[Measure] →→→→→ [Stop] or F3

After confirmation, measurement data receive of RP Monitor stops. The processed mea-

surement values (Min. Ave. Max. Times) are written to the measurement data file.

Toolbar
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6.7 Measurement Method G: Read-Only From Data File Mode

(LAN)

(1) Particle counter connection

[1] As shown below, data are received in this configuration not from particle counters but

from the file system of an existing computer, shared via a LAN. This mode can be

used for particle count display at a remote location.

(2) Select [Options] →→→→→ [Measuring Mode] →→→→→ [Read Only xxxxxx] →→→→→
[From Data File (LAN)]

"xxxxxx" stands for one of the following modes:

- Multi mode (R)

- Multi mode (R) plus 330 mode
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(3) Measurement parameter setting

[Measure] →→→→→ [Setup] or F4

Refer to section 7 "Measurement Steps for Each Measurement Method" and set the pa-

rameters for measurement method G.

(4) Measurement start

[Measure] →→→→→ [Start] or F5

Starts the process for receiving particle counter measurement data.

Note:
- The file system specified in the Data Path is monitored in intervals of 10 seconds.

When measurement data were updated, the data are read in.

- In this mode, no measurement data file can be created (stored).

- Measurement data cannot be output via RS-232C port of computer.

- The Data Path for the particle counter should be set to the network drive.

(Using the supplied Kfilecpy.exe program, it is also possible to regularly copy the

file to another computer and specify the target folder for reading in measurement

data.)

- Control of particle counters by RP Monitor and control of master RP Monitor is not

possible.

- The Command column of the real-time display shows only "Row Count n", indicat-

ing the line in the measurement data file. This may be different from the count of the

master RP Monitor.

(5) Measurement end

[Measure] →→→→→ [Stop] or F3

After confirmation, measurement data receive of RP Monitor stops.
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6.8 Measurement Method H: Multi Mode (R)

(1) Particle counter connection and setup

[1] As shown below, connect the particle counters to the COM port of the computer, via

bus line, sub line, and converter.

[2] Particle counter setup

- Refer to the documentation of the particle counter to set the node address.

(Any address between 0 and 19 can be chosen, but node addresses must be unique.)

- Set the network delay for applicable particle counters to 20 ms.

- Use the same communication parameters for all nodes. Standard setting is 4800 bps.

(2) Measurement parameter setting

[Measure] →→→→→ [Setup] or F4

Refer to section 7 "Measurement Steps for Each Measurement Method" and set the pa-

rameters for measurement method H.
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(3) Measurement start

[Measure] →→→→→ [Start] or F5

Sets the particle counter to the measurement condition and starts measurement.

Note:
- The alarm function of the particle counter is synchronized to the RP Monitor alarm

function. When "Alarm = Y" is set at RP Monitor, the alarm relay contacts of the

particle counter are shorted. When Alarm becomes "N", the relay contacts are re-

leased. In units with two sets of alarm contacts, the two sets operate identically.

- When the KZ-45A is used, certain limitations regarding the displayed information

apply. For details, please refer to the documentation of the KZ-45A.

- If an unrecoverable error (disk full error, etc.) occurs during measurement, the mea-

surement stops.

(4) Measurement restart

[Measure] →→→→→ [Restart]

This restarts a particle counter whose power went off during a measurement. It does not

affect other particle counters currently carrying out measurement.

(5) Measurement end

[Measure] →→→→→ [Stop] or F3

After confirmation, measurement stops. The processed measurement values (Min. Ave.

Max. Times) are written to the measurement data file.
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6.9 Measurement Method I: Multi Mode (M)

(1) Particle counter connection and setup

[1] As shown below, connect the particle counters to the COM port of the computer, via

bus line, sub line, and converter.

[2] Particle counter setup

- Refer to the documentation of the particle counter to set the node address (LOC

number).

(Any address between 0 and 19 can be chosen, but node addresses must be unique.)

- Set the communication parameters for all nodes to the same settings.

(Data transfer rate 9600 bps, data bits: 8, stop bits: 1, parity: none)

(2) Measurement parameter setting

[Measure] →→→→→ [Setup] or F4

Refer to section 7 "Measurement Steps for Each Measurement Method" and set the pa-

rameters for measurement method I.
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(3) Measurement start

[Measure] →→→→→ [Start] or F5

Sets the particle counter to the measurement condition and starts measurement.

Note:
- The alarm function of the particle counter is independent of the RP Monitor alarm

function.

- If an unrecoverable error (disk full error, etc.) occurs during measurement, the mea-

surement stops.

(4) Measurement restart

[Measure] →→→→→ [Restart]

This restarts a particle counter whose power went off during a measurement. It does not

affect other particle counters currently carrying out measurement.

(5) Measurement end

[Measure] →→→→→ [Stop] or F3

After confirmation, measurement stops. The processed measurement values (Min. Ave.

Max. Times) are written to the measurement data file.

Toolbar
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6.10 Measurement Method J: KM Memory Receive Multi Mode

With this mode, a particle counter with a buffer memory (such as the KR-12A) can be used

for measurements in the field, storing measurement data temporarily in the buffer. After

measurements are completed, the particle counter is connected to a Multi Mode (M) sub line,

for storing measurement data on a computer.

(1) Preparations

Refer to D: KM Memory Receive Mode.

(2) Measurement parameter setting

[Measure] →→→→→ [Setup] or F4

This is basically the same as for D: KM Memory Receive Mode, but the MaxNodeNo

setting must be added. All particle counters must be of the same model.

Refer to section 7 "Measurement Steps for Each Measurement Method" and set the pa-

rameters for measurement method J.

(3) KM setup

Refer to D: KM Memory Receive Mode.

(4) Mobile measurement

Refer to D: KM Memory Receive Mode.

Toolbar
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Counter Type.

This becomes the location number and is used in the file name (00 to 99).
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(5) Measurement data receive/store

Make connections to the computer as shown below, to store all measurement data to-

gether.

As shown below, connect the particle counters to the COM port of the computer, via bus

line, sub line, and adapter.

For other explanations, refer to D: KM Memory Receive Mode.

The measurement data file name convention is YY (year) MM (month) DD (day) + LOC

number.
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6.11 Measurement Method K: KX-28A Tube Multi-Point Mode

(1) Particle counter connection and setup

[1] As shown below, connect the particle counter to the COM port of the computer.

[2] Equipment setup

KX-28A

- Leave the RS-232C interface settings in the factory default condition.

- Measurement channel setting CHANNEL ON/OFF 1 to 10 Ch

- Sample volume setting SAMPLE VOLUME 0.01 to 10.00 CF

- Measurement period setting Minimum setting: PERIOD (SAMPLE +

PURGE) * Number of channels Unit: minutes

- Purge time setting PURGE 1 to 10 minutes

- Internal clock setting is RP Monitor start time setting.

This is set automatically by the internal clock of

the PC when [Measure] and then [Start] is se-

lected.

KC-25

- Set SAMPLE VOLUME to "MAN".

(2) Measurement parameter setting example

[Measure] →→→→→ [Setup] or F4

Refer to section 7 "Measurement Steps for Each Measurement Method" and set the pa-

rameters for measurement method K.
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(3) Measurement start

[Measure] →→→→→ [Start] or F5

Starts measurement with the particle counters.

Note:
- When starting measurement, verify that the READY indicator of the controller

KX-28A is lit. If the KX-28A is not set up correctly, the READY indicator will not

light. Set the particle counter to the measurement stop condition.

- When measurement is started, the KX-28A controller is set to the remote condition,

making the controls on the operation panel inactive.

- In this mode, only the RM Monitor command for measurement start/stop is used for

particle counter control.

- The sample volume setting of the particle counter is determined not by RP Monitor

but by the KX-28A.

- If an unrecoverable error (disk full error, etc.) occurs during measurement, the mea-

surement is stopped.

(4) Measurement end

[Measure] →→→→→ [Stop] or F3

After confirmation, measurement with the particle counters is stopped. The processed

measurement values (Min. Ave. Max. Times) are written to the measurement data file.

Toolbar
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6.12 Measurement Method L: Manifold Multi-Point Mode (M)

(1) Particle counter connection and setup

[1] Connect the particle counter to the COM port of the computer as shown below.

[2] Measurement sequence program at manifold controller

The manifold performs measurement in up to 100 steps in programmed order, as

shown below. For each step, the port to be measured can be set as desired.

For details, please refer to the documentation of the manifold controller.

Step Measurement port

1 20

2 3

3 1

4 2

5 4

6 11

• •

100 18

Measurement

sequence

� 
 � � � 
 � � � �

� � � � + 
 � �

/ � � � � 	 
 � � � � �

! � 
 " � �

� 
 � � � � �
� 
 � � � � � � 	

� � � 	

� � � 	

1 � � � 	 � � � � � � 
 �

� � � � � � � � � � � 	 � � � � 	 
 � � � � �

/ � � � � 	 � � � � � � � 
 �

� � � � 
 �

/ � � � � 	 � � � � � 	 
 � � � � �

. � � � � � � � � 	 � � � � � 	 � � & � /

� � � � �

� 
 � � � � � �

� 
 � � � � � 	 � 
 	 � � � � � � �

� � � � � � � � 	 � � � � �

� � � � 	 � � 	 � 
 � � � �
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Cycles

Number of

measurement

cycles in each

step

Location

Measurement

sequence repeti-

tions

(0 means endless

repetition)

Operation

1 or more

2 or more

1 or more2 or more

00

0

0

1

1

[3] Particle counter program

By programming the "Cycles" and "Location" settings, various measurements are

possible. The combinations are listed in the table below.

For details, please refer to the documentation of the particle counter.

Measurement is repeated in 1-second intervals at current

port, using measurement time programmed at particle

counter.

Default setting. Each port is measured once, using mea-

surement sequence programmed at manifold controller.

This operation is then repeated.

Each port is measured once, using measurement se-

quence programmed at manifold controller. This opera-

tion is repeated for number of times set with "Location".

Each port is measured for number of times set with

"Cycles", using measurement sequence programmed at

manifold controller. This operation is then repeated.

Each port is measured for number of times set with

"Cycles", using measurement sequence programmed at

manifold controller. This operation is repeated for num-

ber of times set with "Location".
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(2) Measurement parameter setting

[Measure] →→→→→ [Setup] or [F4]

Refer to section 7 "Measurement Steps for Each Measurement Method" and set the pa-

rameters for measurement method L.

(3) Measurement start

[Measure] →→→→→ [Start] or [F5]

Starts measurement.

Note:
- RP Monitor only receives data and controls measurement start/stop.

- The following items cannot be set with the RP Monitor program:

Measurement point selection and sequence (set at manifold controller)

Measurement time and interval (set at particle counter)

- If an unrecoverable error (disk full error, etc.) occurs during measurement, the mea-

surement stops.

(4) Measurement end

[Measure] →→→→→ [Stop] or [F3]

RP Monitor stops the measurement. The processed values (Min, Ave, Max, Times) are

written to the measurement data file.

Toolbar

Toolbar

 Specify location number set at particle counter
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6.13 Measurement Method M: Multi Mode (R) Plus 330 Mode

(1) Particle counter connection and setup

[1] As shown below, connect the particle counters and temperature and humidity sensors

to the COM ports of the computer, via bus line, sub line, and two adapters.

[2] Particle counter setup

Refer to the documentation of the particle counter to set the node address.

(Any address between 0 and 19 can be chosen, but node addresses must be unique.)

(2) Measurement parameter setting

[Measure] →→→→→ [Setup] or F4

Refer to section 7 "Measurement Steps for Each Measurement Method" and set the pa-

rameters for measurement method M.

� 
 � � � � � � 	

� 
 � 0 � � � � �

/ � � � � 	 � � � � � � � 
 �

� � � � 
 �

/ � � � � 	 � � � � � 	 
 � � � � �

� � � 	 � � � 	

� � � 	

� � � � � � � � � � � 	 � � � � 	 
 � � � � � 	

3 � � � � � � � 	 


2 � � � $

9 � � � 	 �

2 � � � $

� � � � 
 � 	 �
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2 � � � $
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� � � � � � � 	 	
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(3) Measurement start

[Measure] →→→→→ [Start] or F5

Sets the particle counter to the measurement condition and starts measurement.

Note:
- The alarm function of the particle counter is synchronized to the RP Monitor alarm

function. When "Alarm = Y" is set at RP Monitor, the alarm relay contacts of the

particle counter are shorted. When Alarm becomes "N", the relay contacts are re-

leased.

- The alarm function of the UM-330 is not synchronized to the RP Monitor alarm

function. It operates independently.

- When the KZ-45A is used, certain limitations regarding the displayed information

apply. For details, please refer to the documentation of the KZ-45A.

(4) Measurement end

[Measure] →→→→→ [Stop] or F3

After confirmation, measurement stops. The processed measurement values (Min. Ave.

Max. Times) are written to the measurement data file.

Toolbar
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7. Measurement Steps for Each

Measurement Method

[Measure] →→→→→ [Setup] or F4

Before using the particle counters for measurement, the measurement parameters must be

set. Parameters include particle counter type, measurement time, sample time, alarm,

value conversion, etc. Parameters can only be set or changed while measurement is

stopped. Changing parameters while measurement is in progress is not possible.

Note:
This explanation applies to all measurement modes. The applicable modes are noted for

each parameter, in the form

� � � � � � � � � � 	 
 � � � � 
 
 � � � � � � � � � � � � � � � � � � � � � � � �

For easier identification, we recommend that you circle the measurement mode that you

are using.

Example:

� � � � � � � � � � 	 
 � � � � 
 
 � � � � � � � � � � � � � � � � � � � � � � � �

A: RS-232C mode

B: Read only RS-232C mode

C: KR-12A  memory receive mode

D: KM memory receive mode

E: Read only multi (R) from bus line

F: Read only multi (R) plus 330 from bus line

G: Read only from data file mode (LAN)

H: Multi mode (R)

I: Multi mode (M)

J: KM memory receive multi mode

K: KX-28A tube multi-point mode

L: Manifold multi-point mode (M)

M: Multi mode (R) plus 330 mode

Toolbar



47

Measurement Steps for Each Measurement Method

COM No. � � � � � � � � � � 	 
 � � � � 
 
 � � � 
 
 � 
 
 � 
 
 � 
 
 � 
 
 � 
 
 � 
 
 � 
 
 � 
 
 � 
 
 � 
 


COM port number of particle counter connected via serial interface. RP Monitor performs

communication on this port.

Node No. � � � � � � � � � � 	 
 � � � � 
 
 
 � 
 
 � 
 
 � 
 
 � � � � � � � � � � � 
 
 � 
 
 � 
 
 � �

Enter the node number (node address) assigned to the particle counter. For multi-point

measurements, the node address is used to identify the hardware (particle counter). For

information on how to set the node address, please refer to the documentation of the par-

ticle counter.

Location No. (FileName) � � � � � � � � � � 	 
 � � � � 
 
 
 � 
 
 � � � � � 
 
 � 
 
 � 
 
 � 
 
 � 
 
 � � � 
 
 � 
 
 � 
 


Measurement point number stored on particle counter at time of measurement (measure-

ment mode D:J) or number allocated at receiving end (measurement mode C:). This num-

ber is used as two characters of the measurement data file name.

Location No. � � � � � � � � � � 	 
 � � � � 
 
 
 � 
 
 � 
 
 � 
 
 � 
 
 � 
 
 � 
 
 � 
 
 � 
 
 � 
 
 � 
 
 � � � 
 


Measurement point number (LOC number) set at particle counter during measurement.

When receiving data, this is used for data identification. The measurement data file name

is as set by the "FileName" item.

Channel No. � � � � � � � � � � 	 
 � � � � 
 
 
 � 
 
 � 
 
 � 
 
 � 
 
 � 
 
 � 
 
 � 
 
 � 
 
 � 
 
 � � � 
 
 � 
 


This refers to the channel number of particle counters for tube multi-point measurement.

Choose the number to match the sampling tube number.  When receiving data, this is used

for data identification. The measurement data file name is as set by the "FileName" item.
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File Name � � � � � � � � � � 	 
 � � � � 
 
 � � � 
 
 � 
 
 � � � � � � � � � � � 
 
 � � � � � �

Enter a two-character code for the measurement point. RP Monitor creates one data file

per measurement point per day and uses this code as the last two characters of the file

name. Therefore it is necessary to change the File Name when performing measurement at

the same location but with different parameters.

Example

950701xx.TXT

Text file extension

MEAS Point code

Measurement date  yy (year) mm (month) dd (day)

In measurement mode other than Read only mode, the measurement point and measure-

ment parameters entered once will be automatically stored in a file. From the next time

onward, it suffices to select the measurement point from the MEAS Point combo box.

This will set all setup items. To delete a measurement point from the combo box, select it

and then set Meas On/Off to Off, so that the MEAS Point field is blank, and press the

Enter key. The point will not be listed during the next particle counter setup run.

This is effective for measuring multiple measurement points with a single particle

counter.

MEAS Point � � � � � � � � � � 	 
 � � � � 
 
 � � � 
 
 � � � � � � � � � � � � � � � � � � � �

A measurement point name can be entered here. The entered string is stored and displayed

together with the measurement result.

Label � � � � � � � � � � 	 
 � � � � 
 
 
 � 
 
 � � � 
 
 � 
 
 � 
 
 � 
 
 � 
 
 � 
 
 � 
 
 � 
 
 � 
 
 � 
 


A measurement point name can be entered here. The entered string is stored and displayed

together with the measurement result. Only alphanumeric characters can be used here.

Enter the same name at the particle counter. The received measurement data are allocated

a file name (Location No.) based on the label entered here.

MEAS On/Off � � � � � � � � � � 	 
 � � � � 
 
 � 
 
 � 
 
 � 
 
 � 
 
 � 
 
 � 
 
 � � � � � 
 
 � 
 
 � 
 
 � �

Selects whether the connected particle counter is to be used for measurement (ON) or not

(OFF). When ON is selected, the particle counter for that channel is controlled by the

software. When OFF is selected, measurement is not carried out with that particle counter.

MEAS On/Off � � � � � � � � � � 	 
 � � � � 
 
 
 � � � 
 
 � 
 
 � � � � � � � 
 
 � 
 
 � 
 
 � � � � � �

Selects whether measurement data are received from the connected particle counter (ON)

or not (OFF). When OFF is selected, measurement data in that channel are discarded.
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Counter Type � � � � � � � � � � 	 
 � � � � 
 
 � � � � � � � � � � � � � � � � � � � � � � � 
 


The type of the connected particle counter can be selected from a combo box. Be sure to

select the correct type. If the particle counter you are using is not on the list, please contact

Rion Corporation.

Out of the list, entries with a special meaning are described below.

KC-03_.5: KC-03 modified for  0.5, 1, 2, 5, 10 um particles

KC-20_5: KC-20 modified for  5, 10, 20, 30, 50 um particles

KA-80A5: KA-80A modified for 5 particle sizes

(0.3 um, 0.5 um, 1 um, 2 um, 5 um)

KA-80B5: KA-80B modified for 5 particle sizes

(0.3 um, 0.5 um, 1 um, 2 um, 5 um)

KS-17A4: KS-17A modified for 4 particle sizes

(0.06 um, 0.10 um, 0.15 um, 0.20 um)

KL-26_LD: KL-26 with light source control capability

KL-27_LD: KL-27 with light source control capability

KL-28T: KL-28 with flow volume sensor

KM-07B_RHT: KM-07B with connected temperature and humidity sensor

KM-07C_RHT: KM-07C with connected temperature and humidity sensor

Temp: Temperature sensor connected to UM-330

R/H: Humidity sensor connected to UM-330

Diff. Pre_H2O: Pressure differential sensor connected to UM-330   Unit: H20

Diff. Pre_Pa: Pressure differential sensor connected to UM-330   Unit: _Pa

AM-09Low: Wind velocity sensor connected to UM-330 Range: 0 to 2.5 m/s

AM-09High: Wind velocity sensor connected to UM-330 Range: 0 to 25 m/s

KR-12A: Measurement/display of 0.3 um, 0.5 um, 0.7 um, 1 um, 2 um, 5 um,

TEMP, R/H

KR-12A_RHT: Measurement/display of 0.3 um, 0.5 um, 0.7 um, 1 um, TEMP, R/H

KR-12A_6CH: Measurement/display of 0.3 um, 0.5 um, 0.7 um, 1 um, 2 um, 5 um,

TEMP, R/H

XP-04+Volts (mV):

Voltage (0 to 1000 mV) measured at XP-04

XP-04+TEMP: Temperature (0 to 50ºC) measured at XP-04

XP-04+TEMP.Humi:

Temperature (0 to 50ºC), CH1 and humidity (0 to 100% RH), CH2

measured at XP-04
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Start Time � � � � � � � � � � 	 
 � � � � 
 
 � 
 
 � 
 
 � 
 
 � 
 
 � 
 
 � 
 
 � � � � � 
 
 � 
 
 � 
 
 � �

Enter the time for the particle counter to start measurement. When Start Time and Stop

Time are both set to 00:00, measurement is carried out continuously. Outside of the mea-

surement time, the particle counter stops measurement.

Start Time � � � � � � � � � � 	 
 � � � � 
 
 
 � � � 
 
 � 
 
 � � � � � � � 
 
 � 
 
 � 
 
 � 
 
 � 
 
 � 
 


Enter the time to begin receiving measurement data from the particle counter. When Start

Time and Stop Time are both set to 00:00, data are received continuously. Outside of the

measurement time, data from the particle counter are discarded.

Start Time � � � � � � � � � � 	 
 � � � � 
 
 
 � 
 
 � 
 
 � 
 
 � 
 
 � 
 
 � 
 
 � 
 
 � 
 
 � 
 
 � � � � � 
 


Enter the time to begin receiving measurement data from the particle counter. When Start

Time and Stop Time are both set to 00:00, data are received continuously. Outside of the

measurement time, data from the particle counter are discarded. When one channel is

within the measurement time, the measurement is started automatically.

Stop Time � � � � � � � � � � 	 
 � � � � 
 
 � 
 
 � 
 
 � 
 
 � 
 
 � 
 
 � 
 
 � � � � � 
 
 � 
 
 � 
 
 � �

Enter the time for the particle counter to stop measurement. When the time is exceeded,

the particle counter stops measurement.

When Start Time and Stop Time are both set to 00:00, measurement is carried out continu-

ously.

The Stop Time cannot be set to an earlier time than the Start Time.

Stop Time � � � � � � � � � � 	 
 � � � � 
 
 
 � � � 
 
 � 
 
 � � � � � � � 
 
 � 
 
 � 
 
 � 
 
 � 
 
 � 
 


Enter the time to stop receiving measurement data from the particle counter. When the

time is exceeded, the particle counter continues measurement, but measurement data are

no longer received or stored.

Stop Time � � � � � � � � � � 	 
 � � � � 
 
 
 � 
 
 � 
 
 � 
 
 � 
 
 � 
 
 � 
 
 � 
 
 � 
 
 � 
 
 � � � � � 
 


Enter the time to stop receiving measurement data from the particle counter. When the

time is exceeded, the particle counter continues measurement, but measurement data are

no longer received or stored. When all channels are outside the measurement time, the

measurement is stopped automatically.
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Sample Time (S) � � � � � � � � � � 	 
 � � � � 
 
 � 
 
 � 
 
 � 
 
 � 
 
 � 
 
 � 
 
 � 
 
 � 
 
 � 
 
 � 
 
 � 
 
 � 
 


Enter the time for which the particle counter should perform measurement (in seconds).

The volume to be measured is automatically displayed as the Sample Volume. The small-

est possible setting is 1 second, and the maximum setting is 86400 seconds (24 hours).

Sample Time accuracy of RP Monitor is ±1 second or within ±5%.

When measurement at actual measurement time ±1 second or within ±5% could not be

carried out, a correction error is diagnosed and the particle count is converted to time.

Conversion equation:

Count = particle count × sampling time (s) / actual measurement time (s)

Note:
About built-in alarm function of particle counter

When a particle counter with built-in alarm function is used with RP Monitor, care

must be taken when using alarm function of the particle counter. If RP Monitor is

controlling the particle counter and the program stops, pauses, or crashes, alarm moni-

toring at the particle counter may be stopped or impaired.
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Sample Time (S) � � � � � � � � � � 	 
 � � � � 
 
 
 � 
 
 � 
 
 � 
 
 � 
 
 � 
 
 � 
 
 � � � � � 
 
 � 
 
 � 
 
 � �

Enter the time for which the particle counter should perform measurement (in seconds).

The volume to be measured is automatically displayed as the Sample Volume. In the case

of temperature or humidity sensors or similar, sampling is carried out once only within the

Sample Time (S) setting.

The smallest setting depends on the number of connected units, as shown below. The

maximum setting is 86400 seconds (24 hours).

1 10 20

2 10 21

3 11 22

4 11 23

5 12 24

6 12 25

7 13 26

8 13 27

9 14 28

10 14 29

• • •

15 17 34

• • •

20 19 39

Sample Time (S) � � � � � � � � � � 	 
 � � � � 
 
 
 � � � � � 
 
 � � � � � � � 
 
 � 
 
 � 
 
 � � � � � 
 


Enter the measurement time set at the particle counter. Use the SAMPLE VOLUME set-

ting of the particle counter (unit: CF etc.) and convert it into measurement time.

For example, if the setting at the particle counter for the flow rate is 30 L/s and the

SAMPLE VOLUME = 1 CF, the following applies.

1 CF = 30 × 60 = 56.6 (unit: seconds)

Sample Time (S) � � � � � � � � � � 	 
 � � � � 
 
 
 � 
 
 � 
 
 � � � 
 
 � 
 
 � 
 
 � 
 
 � 
 
 � � � 
 
 � 
 
 � 
 


Enter the measurement time set at the particle counter so that a match is achieved. Enter

the setting to obtain the sample volume.

Number of

connected units

Minimum sample

time (Sample)

Minimum measure-

ment interval (Period)
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Sample Volume � � � � � � � � � � 	 
 � � � � 
 
 � � � � � � � � � � � � � � � � � � � � � � � �

Indicates the actually measured amount (in units of L, CF, etc.). Displayed automatically

when Sample Time is input. The item is for display only, it cannot be changed directly. For

process particle counters, the sample volume is not determined, and this field only shows

"----".

Period � � � � � � � � � � 	 
 � � � � 
 
 � 
 
 � 
 
 � 
 
 � 
 
 � 
 
 � 
 
 � 
 
 � 
 
 � 
 
 � 
 
 � 
 
 � 
 


Enter the cycle duration (seconds) in which the particle counter repeats measurement.

This should be Sample Time + time required for Auto Cal + 1 s or more. The minimum

setting is 2 seconds, and the maximum 86400 seconds (24 hours).

Period � � � � � � � � � � 	 
 � � � � 
 
 
 � 
 
 � 
 
 � 
 
 � 
 
 � 
 
 � 
 
 � � � � � 
 
 � 
 
 � 
 
 � �

Enter the cycle duration (seconds) in which the particle counter repeats measurement. The

minimum setting depends on the number of connected units, as shown in the Sample Time

table above. The maximum setting is 86400 seconds (24 hours).

Alarm Size (um) � � � � � � � � � � 	 
 � � � � 
 
 � � � � � � � � � � � � � � � � � � � � � � � �

RP Monitor allows alarm comparison. After measurement of a certain volume, the result

is converted into a standard value using the Conv. Factor and then compared to the alarm

value. When the converted value exceeds the alarm level set for the specified Alarm Size,

and when a real-time window has been opened, the indication "Alarm = Y" is shown in

red, and "Alarm = Y" is also stored in the measurement data file.

When an optional alarm unit is connected (in some measurement modes, no alarm unit can

be connected), relay contacts are closed and can be used to operate a rotating warning light

or buzzer.

When Alarm Size is set to OFF, no alarm comparison is carried out.

Alarm Upper Level � � � � � � � � � � 	 
 � � � � 
 
 � � � � � � � � � � � � � � � � � � � � � � � �

Enter the upper limit for alarm comparison. After measurement of a certain volume, the

result is converted into a standard value using the Conv. Factor and then compared to the

alarm value. When the converted value is lower than the alarm level set for the specified

Alarm Size, "Alarm = Y" is output.

When Alarm Size is set to OFF, no alarm comparison is carried out.

� � � � � �

� � � � � � 
 � � � � 


� � � � � � � � � � 	

� 	 � � 	 
 � � � � � 	 � � 
 � � � �

� � � � � � � � � � 	 � � � � � � � � � � 	

� � � � � � 
 � � � � � � � � � � 
 � � � �

� � � � � � � � � � � �
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Alarm Lower Level � � � � � � � � � � 	 
 � � � � 
 
 � � � 
 
 � 
 
 � � � � � � � � � � � 
 
 � � � � � �

Enter the lower limit for alarm comparison. After measurement of a certain volume, the

result is converted into a standard value using the Conv. Factor and then compared to the

alarm value. When the converted value is lower than the alarm level set for the specified

Alarm Size, "Alarm = Y" is output.

When Alarm Size is set to OFF, no alarm comparison is carried out.

Conv. Factor � � � � � � � � � � 	 
 � � � � 
 
 � � � � � � � � � � � � � � � � � � � � � � � �

The particle count measured by the particle counter is converted to the unit specified by

this item. All particle counts displayed by RP Monitor are the values after conversion.

However, data files created by RP Monitor contain the raw data before conversion.

Measurement data for temperature, humidity, etc. are not converted.

When Conv. Factor is set to a value other than OFF, count values are displayed with

decimal point resolution.

When you click on  SAVE , the following message may be displayed, indicating that the

particle counter display value has been compensated according to a count efficiency ratio.

(As of February 2001, this applies only to KS-17.)

- When Conv. Factor is set to OFF, the raw count is displayed.

- When Conv. Factor is set to a value other than OFF, the count value is compensated

by the count efficiency ratio.

Example 1: Conv. Factor = OFF, (KS-17) measurement time 1 min., count

value 5, indication 5

Example 2: Conv. Factor = 10 mL, (KS-17) measurement time 1 min., count

value 5, indication 500
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Dispense Times � � � � � � � � � � 	 
 � � � � 
 
 � � � 
 
 � 
 
 � � � � � 
 
 � � � � � 
 
 � � � � � �

Specifies the number of blank measurements. During the specified interval, measurement

data are displayed but are not stored in a data file, and real-time graph display processing

is not carried out. Use this for installations with long sampling tubes or when changing the

sample volume of a syringe sampler.

Ave Times � � � � � � � � � � 	 
 � � � � 
 
 � � � 
 
 � 
 
 � � � � � 
 
 � � � � � 
 
 � � � � � �

Enter the shift average count. When "1" is entered, no shift averaging is carried out. Set-

tings of 2 or higher cause all values displayed and stored by RP Monitor to be subject to

shift averaging. The data before averaging (raw data) are discarded. Use this when the

measurement data fluctuate considerably.

Example: Ave Times = 3

Particle counter count 10 → 20 → 30 → 40 → 50 → 30 → 10

RP Monitor count × → × → 20 → 30 → 40 → 40 → 30

RP Monitor real-time display (Count) 1/3 → 2/3 → 1 → 2 → 3 → 4 → 5

MEAS Times � � � � � � � � � � 	 
 � � � � 
 
 � � � 
 
 � 
 
 � � � � � 
 
 � � � � � 
 
 � � � � � �

Measurement automatically stops after the specified number of times. After measurement

was stopped, it will not start again also at the next start time. Use this setting when making

measurements with a syringe sampler. It can be used to automatically stop measurement

before running out of sample fluid. When a value of "-1" is entered, measurement is car-

ried out continuously. In relation to the Stop Time setting, the setting that is fulfilled first

has priority.

Standby Mode � � � � � � � � � � 	 
 � � � � 
 
 � 
 
 � 
 
 � 
 
 � 
 
 � 
 
 � 
 
 � � � � � 
 
 � 
 
 � � � �

This setting serves for automatic control of the particle counter light source and pump.

When set to "On", particle counters with a gas laser light source will operate as follows.

When measurement pause is more than 60 minutes, the light source and pump will be

turned on 10 minutes before measurement, and will be turned off 1 minute after measure-

ment. Particle counters with a laser diode light source will operate as follows. When mea-

surement pause is more than 3 minutes, the light source and pump will be turned on 1

minute before measurement, and will be turned off 1 minute after measurement. Measure-

ment starts on full 00 minutes (xx:xx:00). When the setting is "Off", light source and

pump are not automatically controlled and measurement starts immediately.

In installations where the particle counter is always switched on, such as for clean-room

monitoring, the setting should be "On" to reduce wear of the light source and pump.
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Help ? � � � � � � � � � � 	 
 � � � � 
 
 � 
 
 � 
 
 � 
 
 � 
 
 � 
 
 � 
 
 � � � � � 
 
 � 
 
 � � � �

Displays the current measurement time chart. The example below is for the settings

Sample = 60 seconds, Period = 120 seconds, Dispense Times = 5, MEAS Times = 10.

Syringe Mode � � � � � � � � � � 	 
 � � � � 
 
 � 
 
 � 
 
 � 
 
 � 
 
 � 
 
 � 
 
 � 
 
 � 
 
 � � � 
 
 � 
 
 � 
 


When Syringe Mode is set to ON, no stop command is sent to the particle counter at the

end of each sampling cycle. This allows correct measurement when using a syringe sam-

pler. (When using a syringe sampler, the stop command is issued by the syringe sampler.)

Cycle Time (M) � � � � � � � � � � 	 
 � � � � 
 
 � 
 
 � 
 
 � 
 
 � 
 
 � 
 
 � 
 
 � � � � � 
 
 � 
 
 � 
 
 � �

When you enter the number of measurements (Meas Times) and cycle time (unit: min-

utes), measurements are carried out at the interval set here. With an input of "-1", measure-

ment terminates then the number of measurements has been carried out.

A measurement example for a setting Dispense Times (blank measurement count) setting

of 1, MEAS times (measurement times) setting of 2, and CycleTime (repeat time) setting

of 15 minutes is shown below.

A measurement example for a setting Dispense Times (blank measurement count) setting

of 1, MEAS times (measurement times) setting of 2, and CycleTime (repeat time) setting

of -1 is shown below.
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Save � � � � � � � � � � 	 
 � � � � 
 
 � � � � � � � � � � � 
 
 � � � � � � � � � � � �

Input the measurement conditions for particle counter setup. When the updated items are

correct, click on the [Save] button. When the button is clicked, the updated items become

effective and are stored in the default value file.

If a measurement data file has already been created with the conditions before the change,

data cannot be added to this file after the change. Therefore a confirmation message ap-

pears and the name of the already created file is changed. The name change is effected by

adding a $ to the beginning of the name. With each rename action, the $ moves one place

to the right (example: 9$50101aa.txt). Therefore up to 8 rename actions are possible. Note

that the file will be deleted when this number is exceeded.
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Approximate required disc capacity for storing measurement data is shown in the table

below. For 5-channel type particle counters, the reference model is KC-01C, and for 2-

channel type particle counters the reference model is KL-28.

Measurement data for 1 day Measurement data for 30 days Measurement data for 1 year

Measurement cycle KL-28 KC01C KL-28 KC-01C KL-28 KC-01C

60 min. 1.4 2.0 33.4 48.2 396.9 574.2

30 min. 2.5 3.6 66.4 96.0 793.4 1,147.9

10 min. 6.9 10.0 198.6 287.3 2,379.7 3,442.9

5 min. 13.5 19.5 396.9 574.2 4,759.1 6,885.4

1 min. 66.4 96.0 1,983.1 2,869.2 23,794.1 34,425.4

30 sec. 132.5 191.7 3,965.9 5,737.9 47,587.8 68,850.4

10 sec. 396.9 574.2 11,897.2 17,212.9 142,762.8 206,550.4

5 sec. 793.4 1,147.9 23,794.1 34,425.4 285,525.3 413,100.4

KL-28  header approx. 137 + 47 bytes * (number of measurements per day + 4 (Ave)) Unit: KB

KC-01C  header approx. 154 + 68 bytes * (number of measurements per day + 4 (Ave))

Save � � � � � � � � � � 	 
 � � � � 
 
 
 � 
 
 � 
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 � 
 
 � 
 
 � � � 
 
 � 
 
 � 
 
 � 
 
 � 
 
 � 
 


Match the particle counter setup to the master RP Monitor.

When the updated items are correct, click on the [Save] button. When the button is

clicked, the updated items become effective and are stored in the default value file.

If a measurement data file has already been created with the conditions before the change,

a confirmation message appears. Be sure to match the settings with those of the master RP

Monitor.

Cancel � � � � � � � � � � 	 
 � � � � 
 
 � � � � � � � � � � � � � � � � � � � � � � � �

Allows terminating setup without accepting changed items. Click on this button to close

the setup window.
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ALM Sound � � � � � � � � � � 	 
 � � � � 
 
 � � � 
 
 � 
 
 � � � � � � � � � � � 
 
 � � � � � �

When this is checked, a sound is produced by the PC when the "Alarm = Y" condition

applies. The sound is produced when any of the nodes becomes "Alarm = Y". The sound

stops when all nodes have become "Alarm = N".

To temporarily turn off the sound, click on the tool bar.

RP Monitor uses the general Windows 95 alarm sound.

The alarm sound of RP Monitor plays the file RP_ALM.WAV located in the same folder

as the program. By overwriting this file, you can change the alarm sound to any other

WAV file, if desired.

Sound Test � � � � � � � � � � 	 
 � � � � 
 
 � � � 
 
 � 
 
 � � � � � � � � � � � 
 
 � � � � � �

Click here to play the RP Monitor alarm sound. This allows you to test the sound during

measurement, even if not in the Alarm = Y condition.

Data Path � � � � � � � � � � 	 
 � � � � 
 
 � � � � � � � � � � � 
 
 � � � � � � � � � � � �

Specifies the disk drive and folder name where measurement data are to be stored.

Note:
When several particle counters are controlled or when measurements are carried using

a cycle of several seconds only, a fast-responding environment is necessary. There-

fore you should specify a hard disk, not a floppy disk as target for saving data (Data

Path).

Data Path � � � � � � � � � � 	 
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 � 
 
 � 
 
 � 
 
 � 
 
 � 
 


Specifies the disk drive and folder name where measurement data are to be monitored and

received.

To specify the file system of a computer, use the network functions to assign a network

drive, and then enter that drive name.

Counter COM No. � � � � � � � � � � 	 
 � � � � 
 
 
 � 
 
 � � � � � � � � � 
 
 � � � � � � � � � � � �

For multi-point measurement, the particle counter is connected to the COM port on the

computer, either via an adapter (RS-485 interface) or directly (RS-232C interface). Select

the number of the COM port to which the particle counter is connected. If not used, set this

item to OFF.

UM330 COM No. � � � � � � � � � � 	 
 � � � � 
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 � 
 
 � 
 
 � �

For temperature and humidity measurements, the UM-330 is connected to the COM port

of the computer using an adapter. Select the number of the COM port to which the adapter

is connected. If no adapter is used, set this item to OFF.
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Output COM No. � � � � � � � � � � 	 
 � � � � 
 
 � � � 
 
 � 
 
 � � � � � 
 
 � � � � � 
 
 � � � � � �

An external alarm relay unit (option) or contamination indicator panel (option) can be

driven by measurement data output via a COM port. Select the number of the COM port

here. If the feature is not used, set this item to OFF. For information on the output format,

see the end of this documentation.

Max Node No. � � � � � � � � � � 	 
 � � � � 
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 � 
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 � 
 
 � 
 


When memorized measurement data are received simultaneously, the node address (LOC

number) of the last particle counter is entered here. RP Monitor will receive measurement

data from particle counters up to and including that node address.

Note:
Using keyboard shortcuts makes the entry process easier: Copy = [Ctrl] + [C], Cut =

[Ctrl] + [X], Paste = [Ctrl] + [V])
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8. Automatic Measurement Start

Click on [Options] →→→→→ [Measure Auto Start]
The next time RP Monitor is started up, measurement begins automatically. This option

serves for unmanned installations where carrying out measurement without mouse input is

desirable.

If RP Monitor is registered in the Windows startup folder, this function allows automatic

measurement start when power to the computer is turned on.

Options can also be specified when starting RP Monitor. For example, it is possible to start

the program, automatically open a real-time graph in full screen view, and start measurement

automatically. This is accomplished by writing key macro commands on the 3rd line of the

file RP_MONI. ini located in the program folder. (Key macro command syntax is proprietary

to RP Monitor. Please contact Kyushu Rion Corporation for information.)

When the file RP_MONI. ini has been edited, you must restart RP Monitor for the changes to

take effect.

Example 1

Automatically open real-time graph and start measurement.

Command: time010.{F2}.time003.%( )X{F2}%(-)X.time003.%(MS)

Action: Pause 10 seconds, open maximized real-time graph; pause 3 seconds,

maximize display, pause 3 seconds, start measurement.

Example 2

Automatically open real-time graph and real-time numeric display, adjust size, and start

measurement.

Command: time010.%( )X  .time003.{F2}  .time003.{F1} .time003.%(WT)  .time003.%

(-)S{DOWN}{UP 7}{ENTER} .time003.%(-)T%(-)S{UP}{UP 7}{EN-

TER}  .time003.%(MS)

Action: Pause 10 seconds, maximize display, open real-time graph, open real-time

numeric display, arrange windows as vertical tile, adjust menu box size, go

down 1 step, go up 7 steps, Enter, move to next window, change size, go up

1 step, go up 7 steps, Enter, start measurement.
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9. View

9.1 Map window

[View] →→→→→ [Map] or F6

The current particle counter layout diagram with color-coded node icons for alarm indication

and error indication is shown. From this window, it is possible to open a real-time history

window and alarm window for each measurement point.

Node icon

Clicking on the icon brings up a sub window.

The icon can be moved by dragging it while holding down the Shift key. The new

position will be memorized.

Clicking while holding down the Ctrl key rearranges the icons.

Clicking by holding the Shift key + Ctrl key toggles between two display styles.

The color of the icon during measurement has the following meaning.

Green: Alarm = N

Yellow: Measurement error has occurred

Red: Alarm = Y

Toolbar

For channels shown with a large icon, set the real-

time graph particle size ON/OFF switch for the cor-

responding node to Draw.

By holding the mouse

cursor over a node icon

for a while, tool tips will

be displayed showing the

latest measurement val-

ues. Note that the display

will not be automatically

updated when measure-

ment values change.

Double-clicking in the display brings up Paintbrush which

can be used to edit the layout diagram. Save the result us-

ing the file name RP_MAP.BMP.
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- When the window is opened, a RPMAP.BMP file that exists in the program file

folder will be shown. The display size is the size that was used when creating the

file. (The size can be changed with ZOOM.)

- Clicking on a node icon brings up a window. From this window, you can open a

real-time window or history window.
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9.2 Real-Time Numeric List Window

[View] →→→→→ [Real Time Open] →→→→→ [Numeric] or F1

The commands and measurement results for all currently operating particle counters are

shown.

For one-channel display, scrolling shows the history.

For multi-channel measurement, results for all nodes are shown.

Toolbar

New data

Measurement time Command Particle count Alarm indication Error indication

Temperature Relative humidity

Measerment location name + File name Right-clicking inside the window toggles the

background color between blue and white.
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- Commands shown in the "Command" field

Reset: Reset command sent to particle counter.

Remote: Remote command sent to particle counter.

LD ON: Light source ON, pump ON commands sent to particle counter.

Active: UM-330 operates normally. Correct command response received.

Dispense 2: Blank measurement in progress. Two actions remaining.

Count 3: Measurement start command sent to particle counter (measurement

count = 3).

Count 1/5: Shift average 5 set, current average count insufficient (data are being

accumulated). Measurement data not yet ready.

Stop 3: Measurement stop command sent to particle counter (measurement

count = 3).

Row Count 3:

Shows number of row in file being read in read-only file mode

Read: Data request command sent to particle counter (KM-07 only)

LD OFF: Light source OFF, pump OFF commands sent to particle counter.
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9.3 Real-Time Graph Window

[View] →→→→→ [Real Time Open] →→→→→ [Graph] →→→→→ [Select measurement location]

To open real-time graph for node 0 (COM1)

[View] →→→→→ [Real Time Open] →→→→→ [Graph] →→→→→ [Node 0] or F2

To open a real-time graph for all measurement locations

[View] →→→→→ [Real Time Open] →→→→→ [Graph] →→→→→ [All Points]

Note:
Only values above 0 can be plotted on the graph. Negative values cannot be plotted.

Toolbar

Toolbar

By right-clicking in the window dur-

ing printing, the background color

can be toggled between gray and

white.

For easier legibility of the printout,

the background is white.

Command Particle count Alarm indication Error indication

Time markerDouble-clicking switches between

graph setup window and graph display.

Clicking here brings up graph setup

window.
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9.4 History Numeric Window

[View] →→→→→ [History Open] →→→→→ [Numeric]

A file selection dialog box opens. Select the desired file and click on [OK].

The file name convention is yy (year) mm (month ) dd (day) + measurement point name.txt

When the file was loaded properly, the following kind of window appears. The last lines

show the statistical values from start to end of measurement (maximum value and update

time, average value, minimum value and update time, normal measurement count). The

maximum, average, and minimum values are calculated separately for each particle size. The

update time is the time for the smallest particle size channel (ch1). The particle count has

been converted to the unit specified by the Conv. Factor.

Select file After selecting file, click on [OK]

Statistical values

Max, Ave, Min

Right-clicking inside the window toggles the

background color between blue and white.



68

View

9.5 History Graph Window

[View] →→→→→ [History Open] →→→→→ [Graph]

A file selection dialog box opens. Select the desired file and click on [OK].

The file name convention is yy (year) mm (month ) dd (day) + measurement point name.txt

The following kind of window appears, and the measurement data for one day are shown in

graphical form. The particle count has been converted to the unit specified by the Conv.

Factor.

Graph readout function

With the readout function, the following values can be read.

- Normal graph and integral graph shown for same time (point) → integral graph value

- Previous graph and normal (today's) graph shown for same time (point) → normal

(today's) graph

When the window size is reduced, the readout display automatically disappears.

When the window is small and number of measurements is high, the readout value shows

the maximum value for that time (point).

The "← "and "→" arrow keys can also be used to move the readout marker.

Select file After selecting

file, click on

[OK]

When "Readout" has

been set to ON in

g r a p h  s e t u p ,  t h e

mouse can be used to

move the readout

marker and read the

value for that point.

Readout marker

Clicking here brings up

graph setup window.
Particle size label shows position where

count exceeded 0 for the first time.

Double-clicking brings

up graph setup window.
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9.6 Graph Setup

Clicking on the graph icon, or double-clicking on the X title (date) or the Y title (count unit)

in the graph brings up the setup window. The time graph setup information is saved for each

node separately when the setup information is modified.

Log/Lin: Selects a logarithmic scale or linear scale for the vertical axis of the graph.

Style: Selects the type of line used for the graph.

ThinOut: Number of points that are omitted. When the number of measurements is

high, this is set automatically when the graph is opened, but it can also be

changed in the setup window. When "0" is selected, all data points are dis-

played.

StartDate: Display start date for left end of graph

StartTime: Display start time for left end of graph

EndDate: Display end date for right end of graph

EndTime: Display end time for right end of graph

Bottom: Count value for lower end of graph

Top: Count value for upper end of graph

Previous: ON/OFF switch for displaying measurement results of previous day

Particle size ON/OFF switch:

Set the switches for the desired particle sizes to "Draw".

Color: Serves for specifying the graph color.

Integral: Displays the integral graph.
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- Style Selects the graph line type.

- Readout Allows using the mouse to read the values for any point.

- Color Specifies the color for the graph.

First select a color

Then click on [OK]

Clicking here

while holding

down the Ctrl

key returns to

the initial po-

sition.

Readout display

Use the mouse (or arrow

keys) to specify the de-

sired point and read the

measurement values.

The display can be

dragged.
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- Integral Displays the integral graph.

The integral graph accumulates the particle count and displays it when it reaches a certain

specified quantity.

Example: graph setup

Because the measured volume is added for calculating the integral value, the sample volume

must be equal to or an integer multiple of the integral volume.

Integral volume set to 1 L (liter)

Measurements for 10 ml each are added 100

times, and result is converted to 1 liter reading

0.5 µm:1 L display
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9.7  History Graph Comment Display and Printing

You can enter relevant information during measurement in the comment field and print

out this information later.

- Information entered in the comment field is saved for each node along with other

graph information. It is not saved in the measurement data file and has no effect on

this file.

- Only the most recent version of the comment is saved (same comment for graph and

list).

- The comment is saved when the current graph or list display is closed.

- If the comment field is not changed from the default condition ("Comment for

printing"), it will not be printed.
When Comment is set to ON, the comment field is

shown for the graph or list display.

If anything is entered in the comment field, it will be

printed when a hard copy is produced.  You can move

the comment field by dragging it.
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9.8  History Numeric Comment Display and Printing

Any string entered here will be printed.

Print example

String entered

History Numeric (Total) c:\RP_MONI\DATA\000110P1.TXT

Comment ABC

MEAS Counter Sample Sample Alarm Upper Lower Conv

Point Type (sec) Vol Size Level Level Factor

P1 KA-80B 60 1.000L 0.3 -999 100000 OFF

Date Time 0.3um 0.5um Alarm Error

00-01-10 17:05:00 121862 11935 Y

00-01-10 17:07:00 142673 14436 Y
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9.9 Alarm or Error List Window

(1) Alarm List Window

[View] → [Alarm or Error List]

The window below appears. After selecting "Alarm List", select the measurement point

and date and click on the [OK] button. The "Alarm = Y" measurements will be displayed.

- The maximum number of lines that can be displayed by the alarm list is 1000.

Toolbar

Select measurement point

Display start date

Display end date

Select Alarm List

Click on [OK]

Measurement date and time
Particle count All alarm indications are "Y" Error indication

Right-clicking inside the window toggles the

background color between blue and white.

Temperature Relative humidity
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(2) Error List Window

[View] → [Alarm or Error List]

The window below appears. After selecting "Error List", select the measurement point and

date and click on the [OK] button. The measurements where an error has occurred will be

displayed.

- The maximum number of lines that can be displayed by the error list is 1000.

Select measurement point

Display start date

Display end date

Select Error List

Click on [OK]

Measurement date and time Particle count Alarm indication Error indication

Right-clicking inside the window toggles the

background color between blue and white.
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9.10 Error Messages in Error Column and Countermeasures

If an error message is shown in the error column, but the background color* does not change

(remains blue), the measurement count display shows the effective count as received from

the particle counter. This kind of error is called a "non-fatal error" in RP Monitor.

If an error message is shown and the background color has changed to yellow, the count

indication is invalid. Such an error is called a "measurement data invalid error". (The count

indication reads "0" but this is not necessarily the actual count.)

Measurement data where a "non-fatal error" has occurred are still included in alarm compari-

son and processing of measurement results. Measurement data where a "measurement data

invalid error" has occurred are not used for alarm comparison and are excluded from process-

ing.

Measurement data invalid errors

Power OFF: There is no response from particle counter. Particle counter will be

excluded from control.

At the next Start Time (00:00:00), response check is carried out once

more. Using [Restart], the particle counter only can be started for

measurement.

Countermeasure: Check particle counter connection and power status.

Countermeasure: Connect UM-330 correctly and check communications parameter

setup.

Timeout Err: Communications error. No measurement data are being sent from

particle counter.

Countermeasure: Check particle counter connection and power status.

Particle count display *: The background color
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NAK Err or NAK=xxx (ER3 etc.):

Particle counter response problem.

Particle counter cannot execute a command for some reason.

Countermeasure: If xxx is a code (such as ER3), refer to interface section in particle

counter documentation.

Example: If syringe sampler is used but measurement start timing is inap-

propriate, NAK=ER3 will be returned.

Example: If light source of KE-28 does not work properly, NAK=R/ER3

will be returned.

RD Timeout: Communications error. No response from particle counter.

Countermeasure: Check particle counter connection and power status.

Countermeasure: Check whether COM port number setting is correct.

CS OFF Err: Communications error. RS-232C interface is not active, or RS-485

multi-bus send/receive control does not work.

Countermeasure: Check particle counter connection and power status.

Countermeasure: Use proper RS-232C cable.

Chksum Err: Communications error. Characters have become corrupted due to

noise or other factors.

Countermeasure: Install unit in an environment that is as noise-free as possible.

Not Start: Measurement could not be started at preset time.

Countermeasure: Do not use other applications on the computer during measure-

ment.

330ER=x: Communications error. An error has occurred during communication

with UM-330.

Countermeasure: Check connections and UM-330 parameter setup.

ADErrorD1: An error (D0001) has occurred in A/D converter of UM-330 input.

Countermeasure: UM-330 is defective. Contact service representative.

PVErr=x: A PV error (D0002) has occurred at UM-330.

Countermeasure: UM-330 is defective. Contact service representative.

BurnOutErr: Sensor connection cable for UM-330 is interrupted. (When using 1 to

5 V range, voltage has fallen below 1 V.)

Error E1: Error has occurred during measurement with KX-28A.

Countermeasure: Refer to documentation of particle counter.

Counter Err: Received data contained a command indicating an error (RS-232C

Mode).

Countermeasure: Refer to documentation of particle counter. (KL-20 "P" or "E" is

shown.)

CounterALM: Particle counter measurement error.

Countermeasure: Refer to documentation of particle counter KM-07 etc.
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Alert E=2: Fatal particle counter error (Multi Mode R). Received measurement/

status data contain "E=2".

Countermeasure: Check particle counter display indication.

Error D=2,3,4...: Particle counter has sent previous measurement data (Multi Mode

R). Occurs for example when particle counter ignores measurement

stop command.

ErrorM=0: Particle counter could not carry out measurement (Multi Mode R).

Occurs for example when particle counter ignores measurement start

command.

Cal Err: Auto calibration of particle counter has failed.

Countermeasure: Refer to documentation of particle counter.

CAL NG: Auto calibration of particle counter has failed.

Countermeasure: Refer to documentation of particle counter.

LD NG: Particle counter laser diode is defective. Measurement could not be

carried out.

Countermeasure: Refer to documentation of particle counter.

LASER NG: Particle counter laser diode is defective. Measurement could not be

carried out.

Countermeasure: Refer to documentation of particle counter.

LD PowerErr: Particle counter laser diode output is below prescribed level (RS-232C

Mode).

Countermeasure: Refer to documentation of particle counter.

LD TempErr: Particle counter laser diode temperature is not within prescribed

range (RS-232C Mode).

Countermeasure: Refer to documentation of particle counter.

Over Range: The count of the particle counter has exceeded the effective number

of digits for measurement data. The particle counter KM-07 etc. has

a display range of 7 digits, but data received via the RS-232C inter-

face can only have a maximum of 6 digits. Therefore RP Monitor can

only display count values up to 999999. When this is exceeded, the

"Over Range" error occurs.

Alternatively, in a measurement using UM-330, the sensor voltage

has exceeded the measurement range.

Under Range: In a measurement using UM-330, the sensor voltage has fallen below

the measurement range.
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Non-fatal errors

Correction:

Measurement could not be carried out in specified measurement time (Sample Time).

Particle count was time-converted according to following formula:

Count = measurement count * sampling time (seconds) / actual

measurement time (seconds)

Countermeasure: Do not use other applications on the computer during measure-

ment.

WarningE=1: A problem has occurred at the particle counter (Multi Mode R). The

received status/measurement data contained the message "E=1".

Countermeasure: Check particle counter display indication.

RD Retry=1,2,3...: Noise during data communication has forced a retry, but correct mea-

surement data could be received.

Cell NG: Contamination or condensation etc. has occurred in particle counter

detector cell, preventing correct measurement.

Countermeasure: Refer to documentation of particle counter.

WARNING(CA: An error has occurred during auto calibration of particle counter.

Countermeasure: Refer to documentation of particle counter KA-81 etc.

Because RP Monitor can display only up to 10 characters in the

error field, the message "WARNING(CAL)" is truncated to

"WARNING(CA".

Low Batt: Internal battery of particle counter is exhausted.

Countermeasure: Refer to documentation of particle counter KM-07 etc.

Make a note of the characters that appear in place of xxx.
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9.11 Tool Bar and Status Bar Contents

The tool bar and status bar show various information items, as explained below.

Alarm list display

Allows checking alarm nodes also without opening the real-time window.

After the list has been called up, the display will remain also when the point changes to

"Alarm = N". This allows checking past alarm conditions.

To reset the alarm list display, click on the reset icon. If the alarm sound is being output, this

will temporarily cancel it.

Data file remaining indication

With each click, the format changes as shown above. When the number of remaining mea-

surement days falls below 30, the display color changes to red (RS-232C, Multi Mode).

Calculation of remaining measurement days is based on the assumption that communication

history is not recorded.

Remaining indication (bytes) Remaining possible number

of measurement days

Remaining display (%)

Alarm Reset icon

Shown in red when "Alarm = Y"

Point name is shown in red when Alarm becomes "Y"

Display during measurementStatus bar Tool bar

Holding the mouse cur-

sor briefly over the node

icon brings up the 20

most recent alarm data.

When the mouse

cursor is moved,

an explanation for

the current item

appears here.
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Date and time indication

With each click, the format changes as shown above.

Monitorbar

The monitor bar shows the RS-232C communication status of particle counter commands.

Display on/off

To turn the respective display off, remove the

check mark from "Tool Barr", "Status Bar" or

"Monitor Bar" in the menu.

Receive command displaySend command display
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9.12 Language Selection

[Options] →→→→→ [Language] →→→→→ [Japanese]

or [Options] →→→→→ [Language] →→→→→ [English]

This software can display messages either in Japanese or in English. Click on the desired

language. Depending on the operating system (Windows), not all messages may be in the

specified language.
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9.13 Single/Total Switching

[Options] →→→→→ [Total/Single]

This selection determines whether RP Monitor shows measurement results as single values

or total values.

Total

Total count of all particles exceeding threshold size in current channel

Single

Total particle count in next higher channel is subtracted from total particle count in current

channel.

CH (example) Total value Single value

0.3um Count of particles 0.3 µm and higher Particle count from 0.3 to 0.5 µm

0.5um Count of particles 0.5 µm and higher Particle count from 0.5 to 1

1um Count of particles 1 µm and higher Particle count from 1 to 2

2um Count of particles 2 µm and higher Particle count from 2 to 5

5um Count of particles 5 µm and higher − − − − − − − − −− − − − − − − − −− − − − − − − − −− − − − − − − − −− − − − − − − − −
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9.14 Error Messages During Measurement and Countermeasures

This section explains messages that may be shown during measurement. Possible counter-

measures are also explained.

Remaining data file capacity low

This message appears when the remaining capacity for the measurement data file in the

specified Data Path becomes 1% or less.

Because further measurement is not possible, measurement is automatically terminated

after the message was shown.

Cannot save measurement data

An error has occurred writing the file, and current measurement data cannot be written.

Remove the cause of the error as quickly as possible.

This error occurs for example when trying to import a data file for a currently ongoing

measurement into Excel.

Up to 100 measurement data can be stored temporarily in the file buffer, but beyond that,

measurement becomes impossible. A message will be displayed and measurement will be

terminated automatically.
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Measurement data cannot be output from COMx

Measurement can no longer be sent via the COM port of the computer to an alarm unit or

contamination indicator panel. Check the power status and connections of related equip-

ment.

If measurement data output should not be used, set the Output COM No. to OFF in the

particle counter setup window.

Up to 100 measurement data can be stored temporarily in the file buffer. Also beyond that,

continued measurement is possible and measurement will not be terminated automati-

cally.

Warning! Measurement in progress, but measurement program does not have control.

RP Monitor is not a fully multi-tasking application. If another application carries out a

lengthy processing sequence, operation of RP Monitor may be interrupted, causing com-

munication errors or other problems.

If the measurement does not respond for a long time (several seconds) during measure-

ment (as can happen for example when a floppy disk is being formatted using File Man-

ager), the above message will appear. In such a case, stop the other program or application.

When the cause has been removed, the message disappears.

This kind of problem is more likely to occur when using a slow PC.

In some cases, the error message may not appear, even if there is a problem (for example

when reading a large measurement file with RP Monitor, or when a mouse button is kept

depressed for a long time during measurement).

When the measurement program was stopped and the start command could not be given

although the specified start time has passed, RP Monitor will display the "Not Start" error

and skip the measurement once. If measurement was stopped after the specified stop time,

the "Correct error" will be generated and time-conversion is performed.
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10. Creating a Monthly Report File

[File] →→→→→ [Monthly File]

Create continuous file for one month: Link (combine) files within specified range to create

monthly file.

Create monthly processing value file: Process files within specified range to create monthly

processing value file.

Move files more than 180 days old: Out of specified range, move files that are more than 180

days old.

For details, see following pages.

Path: Specifies the move target folder.

Point: Select the files to link (combine). Selecting All Points includes all measure-

ment points.

Start: Enter measurement date from which to link files.

End: Enter measurement date up to which to link files.

OK: Start operation with above settings.

Cancel:  Cancel operation and return to previous screen.

If measurement parameters were changed midway, the following message appears. When

you click on [OK], the displayed file is not linked, but the operation continues with the next

file. Clicking on [Cancel] aborts the operation.

Toolbar
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If there is a problem with the target folder (folder does not exist), the following message

appears. Click on Path and change the target folder.
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10.1 Linked Monthly File

To create the file, check the following box.

In modes other than memory receive, RP Monitor creates a file for each measurement point

and each day. These files can be linked to form a monthly file. The last lines of the file

contain the maximum, average, and minimum values for the month.

Daily measurement data file

010101P1.txt

Daily measurement data file

010102P1.txt

Daily measurement data file

010102P1.txt

Daily measurement data file

010102P1.txt

The monthly measurement data file created using the KM memory receive mode originally

does not contain the maximum, average, and minimum values for the month, but the values

can be included by performing the following operation.

Monthly measurement data file

0101KMP1.txt

Monthly\0101__P1.txt

File name for linked file containing data

from 2001/01/01 to 2001/01/31 is

yymm__P1.txt

Monthly linked file

Daily measurement data are collected in a

single file.

Monthly\0101__P1.txt

Maximum, average, and minimum values

for period from 2001/01/01 to 2001/01/31

are calculated and included in the file.

The file name is

yymm__P1.txt
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- Other information

If a linked file with the same name already exists, that file will be deleted and the file for

the newly specified range will be created.

A s  a n  e x a m p l e ,  s e e  t h e  f i l e  S a m p _ p 1 . t x t  l o c a t e d  i n  t h e  f o l d e r

RP_MONI.xxx\Data\Monthly. The linked file can be displayed as a history graph for one

month.
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10.2 Processing Value Monthly File

To create the file, check the following box.

In modes other than KM memory receive mode, RP Monitor creates a file for each measure-

ment point and each day. Data from these files can be used to create a monthly processing

value file at each measurement channel. The last lines of the file contain the maximum,

average, and minimum values for the month.

Daily measurement data file

010101P1.txt

Daily measurement data file

010102P1.txt

Daily measurement data file

010102P1.txt

Daily measurement data file

010102P1.txt

The monthly measurement data file created using the KM memory receive mode can also be

used to create a monthly processing value file. The last lines of the file contain the maximum,

average, and minimum values for the month.

Monthly measurement data file

0101KMP1.txt

Average\0101C1P1.txt

File name for file containing processed

data from 2001/01/01 to 2001/01/31 is

yymmC1P1.txt for channel 1

yymmC2P1.txt for channel 2

C1 is the measurement channel 1 (ex-

ample: 0.3 um) and C2 is the measurement

channel 2 (example: 0.5 um).

Monthly processing value file

Daily measurement data are represented as

one line in the file.

Average\0101C1P1.txt

File name for file containing processed

data from 2001/01/01 to 2001/01/31 is

 yymmC1P1.txt for channel 1

 yymmC2P1.txt for channel 2

C1 is the measurement channel 1 (ex-

ample: 0.3 um) and C2 is the measurement

channel 2 (example: 0.5 um).
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- Other information

If a processing value file already exists in the same file name, that file will be deleted

and the file for the newly specified range will be created.

As an example,  see  the  f i le  Sampc1p1. txt  located in  the  folder

RP_MONI.xxx\Data\Average.

Measurement data

for one day are given

as one line in the

file.
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10.3 Moving Files More than 180 Days Old

After some time of using this system, a considerable number of files will accumulate. This

makes it more time consuming to select a file and can reduce processing speed. Therefore

files more than 180 days old should be moved to a separate folder.

By specifying an external file system or separate computer as the target folder, this function

can be used for backing up measurement data files.

Current measurement folder

Daily measurement data file

 010101P1.txt

Daily measurement data file

 010102P1.txt

Daily measurement data file

 010102P1.txt

Daily measurement data file

 010102P1.txt

Target folder

 010101P1.txt

 010102P1.txt

 010102P1.txt

 010102P1.txt

Move

Original files

are deleted.
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11. Print Menu

When starting to use Windows for the first time, it is necessary to install the correct printer

driver and perform setup.

11.1 Display Font

[File] →→→→→ [Font]
The font used in most RP Monitor windows can be set here.

To display Japanese, select a Japanese font.

11.2 Printer Setup

[File] →→→→→ [Print] →→→→→ [Settings]
The dialog box shown below appears. Select the printer model, print orientation, and pa-

per size. The setting for default printer will apply to RP Monitor and other applications. If

the printer you wish to use is not on the list, you will need to install a printer driver sup-

plied by the printer manufacturer.
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11.3 Printer Fonts

[File] →→→→→ [Print] →→→→→ [Font]
This setting selects which font, style, and point size to use for printing. When using a small

paper size, you should select an appropriate font size to ensure that the entire contents will

fit on the page.

The font selection made here has no effect on graph printing.

11.4 Print

[1] Click on any part of the window you want to print, to make the window active.

[2] Call up the [Print] menu and select printing.

Toolbar
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11.5 Print Samples

- Particle counter setup print sample

Since the data are wide, choose a small font or use the paper in landscape mode.

Particle Counter Setup [RS232C Mode] Ver3.F0 2001/02/13 18:01:00

COM MEAS File MEAS Counter Start Stop Sample Sample Period Alarm Alarm Alarm Conv Ave Dispens MEAS Cycle Syringe Standby

No. Point Name ON/OFF Type Time Time (sec) Vol (sec) Size Lower Upper Factor Times Times Times Time(m) Mode Mode

COM1 MP1 P1 ON KC-03 00:00 00:00 60 2.83L 120 0.3 -999 100000 OFF 1 0 -1 -1 OFF ON

COM2 MP2 P2 ON KC-90 00:00 00:00 10 ---- 20 OFF -999 100 OFF 1 0 -1 -1 OFF ON

COM3 MP3 P3 ON KL-28 00:00 00:00 60 10mL 20 OFF -999 100 OFF 1 0 -1 -1 OFF ON

- History numeric print sample

History Numeric (Total) c:\RP_MONI\DATA\000110P1.TXT

MEAS Counter Sample Sample Alarm Upper Lower Conv

Point Type (sec) Vol Size Level Level Factor

MP1 KA-80B 60 1.000L 0.3 -999 100000 OFF

Date Time 0.3um 0.5um Alarm Error

00-01-10 17:05:00 121862 11935 Y

00-01-10 17:07:00 142673 14436 Y

00-01-10 17:09:00 141548 15837 Y

00-01-10 17:11:00 144943 16367 Y

00-01-10 17:13:00 131257 14197 Y

Max 17:11:00 144943 16367 M.Time=

Ave -:-:- 136457 14554 5

Min 17:05:00 121862 11935

- History graph print sample

Because the on-screen size is preserved when printing, you can change print size by

changing the window size on screen. Adjust the size of the window before printing.
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11.6 Printing Monthly Report Only

[File] →→→→→ [Print] →→→→→ [Print] →→→→→ [Monthly Print]
If a monthly file (example: Monthly/0101_P1.txt) has been read into a window using the

history count display mode, only the maximum, average, and minimum values for that

month will be printed. When this command is executed for any other window, the function

will be the same as for the [Print] command above.

History Numeric (Total) c:\RP_MON\DATA\MONTHLY\0102_P0.TXT

MEAS Counter Sample Sample Alarm Alarm Conv

Point Type (sec) Vol Size Level Factor

P0 KM-80B 60 1.000L 0.3 100000 OFF

****************************   Monthly Report   ****************************

From 01-02-01 00:00:00

To 01-02-28 23:55:00

M.Time 8924

Date Time 0.3um 0.5um

Max 01-02-02 18:40:00 977,981 236,053

Ave  −−−−−:−−−−−:−−−−− 165,442 12,958

Min 01-02-03 14:15:00 22,873 1,378
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11.7 Printing a Specified Range

From the history count display and alarm/error list, the mouse can be used to specify (high-

light) a range to be printed.

Specify range by

dragging mouse and

execute [Print] com-

mand.

Print sample

History Numeric (Total) C:\K9461.300\DATA\SAMPLE.TXT

MEAS Counter Sample Sample Alarm Alarm Conv

Point Type (sec) Vol Size Level Factor

K1 KC-03 60 3.00L 0.3 100000 1CF

Date Time 0.3um 0.5um 1um 2um 5um Alarm Error

Max 15:00:00 93,315 20,216 2,538 311 19 M.Times=

Ave :: 71,467 14,895 1,887 226 9.4 133

Min 17:40:00 47,204 10,235 1,283 160 9.4
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11.8  Automatic List/Graph Printing

1.   From the menu, select [File] →→→→→ [Print] →→→→→ [Print] →→→→→ [Auto Printing].
Alternatively, press the G key while holding down the Ctrl key.

2.   The following window appears.

Select the measurement

point to print

Select the list type

Select how many

graphs to print per

page

Activates the auto

print standby condi-

tion

Starts printing manu-

ally

Specifies print scope

for manual printing
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3.   Making settings
(1) First, select the measurement point to print.

(2) For list (numeric value) printing, select either "Print All List" (print all measure-

ment data) or "Max Ave Min Only" (print only processed measurement data) from

the List Print drop-down menu. When using list printing, the processed values for

the specified print scope will be printed on the last line. To turn list printing off,

select "Print OFF".

(3) For graph printing, select the number of graphs to print per page (1 Graph, 2

Graphs, 3 Graphs, etc.) from the Graph Print drop-down menu. To turn graph print-

ing off, select "Print OFF".

4.   Manual printing
(1) To print manually, specify the Start and End date in the Manual Print frame.

(2) Click on the Manual Print button to start printing.

5.   Auto printing
(1) In the Auto Print Settings frame, select the print scope (1 Day, 1 Week, or 1 Month).

When "1 Day" is selected, printing is carried out every day at a preset time (for

example 9:00). When "1 Week" is selected, printing is carried out every Monday at

a preset time, and when "1 Month" is selected, printing is carried out on the 1st of

every month at a preset time.

(2) Specify the time when printing should be carried out. The input range is 01:00 to

23:00.

(3) The Test Print button can be used to check whether the desired contents will be

printed, without having to wait until the preset Print Time. However, measurement

data for printing must be present.

(4) Clicking the Start Auto Print button puts the system into standby mode for auto

printing. In this condition, the window cannot be closed, and manual printing can-

not be carried out.

(5) When the window is minimized to an icon, two emoticons (^o^) and (^_^) will be

shown alternately, to indicate that an operation is in progress.
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6.   Print example

Sample printout for one week with "Max Ave Min Only" setting
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Sample printout for one week with "4 Graphs" setting
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12. Edit Menu

12.1 Copy

Specify (highlight) a range to be copied by dragging the mouse. Then select [Edit] → [Copy]

to copy the selected range to the clipboard. The contents of the clipboard can then be copied

to another application.

For example, display the alarm list, highlight a range, then select [Edit] → [Copy].

The same applies for graph display. Display the desired graph and click on it to make it

active. Then select [Edit] → [Copy] to copy the graph to the clipboard.

Toolbar

You can then use the Paste command in

Excel to collect measurements where

alarm was triggered into a spreadsheet.

You can use for example the Paste com-

mand in WordPad to paste the graph

into a document.
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12.2 Paste

Selecting [Edit] → [Paste] inserts the contents of the clipboard at the current cursor location.

This can be used for example to repeatedly paste identical strings during particle counter

setup.

12.3 Clipboard - Open

This command serves to open the Windows clipboard, for example to verify whether the

desired content has been copied. When using Windows 95, the Clipboard Viewer must be

installed.

12.4 Clipboard - Close

Serves to close the clipboard.

Toolbar
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13. Windows Menu

13.1 Cascade

When multiple windows are open, this command lets you arrange the windows so that all title

bars are visible.

13.2 Horizontal Tile

This command automatically adjusts window size so that windows can be viewed vertically

side-by-side. The currently active window is placed at the top left.
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13.3 Vertical Tile

This command automatically adjusts window size so that windows can be viewed horizon-

tally side-by-side. The currently active window is placed at the top left.

13.4 Arrange Icons

This command arranges the icons for minimized windows at the bottom of the RP Monitor

screen.

13.5 Close

This command closes the currently active window. Before using the command, click the

mouse on any part of the window to make it active.
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14. Help

The [Help] command brings up a display containing version information and information

about available resources.

GDI Resources

GDI stands for Graphic Device Interface. It manages drawing information used by Win-

dows. When GDI resources are low, drawing instructions by applications cannot be prop-

erly processed. RP Monitor checks the GDI resources before opening a window. When

resources are at 10% or less, it will not open a new window. Close any windows that are no

longer needed.

USER Resources

Manages information about opened windows and window status. When USER resources

are low, new windows cannot be opened. RP Monitor checks the USER resources before

opening a window. When resources are at 10% or less, it will not open a new window.

Close any windows that are no longer needed.
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15. Exporting Data to Excel

How to import data into Excel 97

1. Start up Microsoft Excel.

2. Select [File] → [Open].

3. Select "text file" (*.prn;*.txt;*.csv) as [File Type].

4. Enter the RP Monitor data folder as the browse target folder.

5. From the file list, select the desired file by clicking on it, and then click on the

[Open] button.

6. The text file wizard starts up. Click on [Next] and then [Finish].

7. The RP Monitor data are read into Excel.

Note:
RP Monitor does not lock open files. Therefore it is possible to read a current mea-

surement data file into Excel, although that file is still being used by RP Monitor.

However, Excel will lock the file, causing RP Monitor to lose access to it. This will

cause an error if measurement is in progress, and prevent further measurement. You

should therefore not read current measurement data files into Excel.

Also note that if a large file is being read into Excel while RP Monitor carries out

measurement with another file, the required processing resources may cause a mea-

surement error.
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16. Customizing RP Monitor

RP Monitor reads particle counter information from the file KPARTICL.INI located in the

\RP_MONI folder. By editing the contents of this file, it is possible to modify the display

contents, change communication parameters, and add new particle counter types.

Proceed with care when editing the file KPARTICL.INI. When the file is damaged, measure-

ment and measurement data read-in cannot be performed correctly. Before making any

changes to the file, you should always make a backup copy. If the file has been damaged, you

have to reinstall RP Monitor using the setup floppy disk.

An example for the contents of KPARTICL.INI as opened with Wordpad is shown below.

Example 1: Changing the particle size settings for particle counter KL-28B

Change particle sizes 0.2 um and 0.5 um to 0.25 um and 0.3 um.

In the KL-28B line, change PARTICLE SIZE CH1 to 0.25 um and CH2 to 0.3 um, and

change -SizeSw- from 1 to 0.

Example 2: Change sample volume of particle counter KS-93

Change sample volume from --- to 100 mL

In the KS-93 line, set parameter -A or L or P- to A and SAMPLE VOLUME to 100 mL.
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Example 3: Provide compensation for detection efficiency of KS-16 (72%)

In the KS-16 line, change parameter (%) from 100 to 72. On particle counter setup, set

Conv = 10 mL. If Conv = OFF, compensation is not provided.

After making the above changes, save KPARTICL.INI and restart RP Monitor. If a measure-

ment data file is already present, it should be deleted or moved to another folder, to prevent

mixups caused by different measurement parameters.

Please refer also to the Q_AND_A.DOC file which contains information about other

customization methods.
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17. Using the Supplied Programs

17.1 Communications check program KCHKR485.EXE

This is a communications test program which tests whether communication with a particle

counter is carried out properly and whether the particle counter can be controlled re-

motely. Before using this program, close RP Monitor. Click on the buttons to send com-

mands, and check the operation and response of the particle counter.

485 bus direction indication

CS: OFF  Receiving

CS: ON   Standby to send

Normally CS=ON (green), with brief pe-

riods of CS=OFF (red) when receiving.

Lasting CS=OFF indication contains fol-

lowing error.

- Adapter is not turned on

- COM port number mismatch

- Bus line problem

1. Set to COM port number where

adapter is connected. To change the

setting, set Receive to Off, make the

change, and set it to On again.

2. Select node address to communicate with.

0 to 19 (* specifies broadcast)

3. Command buttons: Send instruction to particle counter.

Check whether particle counter responds properly.

Reset → Ld ON → Start → Stop → ?Data
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17.2 Address setting program KCHKR485.EXE

This program serves for setting the address of the KR-02 etc.

Setting procedure

1. Connect the KR-02 via an adapter.

2. Turn on only the KR-02 for which you want to make the setting. It is not possible to

make settings for several KR-02 units simultaneously.

3. Within 60 seconds of turning on the KR-02, click on [Open Setup]. A message

appears in the receive window. If the message does not appear, first check the con-

nection. If the connection is correct, the baud setting may be mismatched. Click on

[Receive] and set the baud rate to 9600. Then click on [Receive] again and repeat

the procedure from step 2.

4. After selecting the address, click on [Set Address]. You can now set the address.

5. Click on [Set Delay 20] and set the network delay to 20 ms.

6. Click on [Quit Setup] to complete the setting.
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17.3 File copy program KFILECPY.EXE

Make KFILECPY.EXE resi-

dent on the target computer. Do

not make the program resident

on the computer with the mas-

ter RP Monitor.

This program serves for periodically copying measurement data files (*.TXT) to another

computer.  By making this application resident on the copy target, data files created by the

master RP Monitor can be automatically copied to a separate display computer at a differ-

ent location. The MS-DOS XCOPY command is used for this purpose, and only updated

files are copied.

Example:

In the MS-DOS properties for XCopy, check

the "Close on exit" mark.
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18. Measurement Data Output Format

Measurement results (measurement date and time, measurement count) as well as informa-

tion about alarm status and error status (fatal error, non-fatal error) can be output to external

equipment via the RS-232C interface.

18.1  Measurement Data Output

1. The communication parameters are 9600 bps, 8 data bits, 1 stop bit, non-parity,

asynchronous.

2. When sampling for one measurement point is completed, the result is sent as one

frame. This is called a measurement data frame.

3. The structure of a measurement data frame is shown below.

The first byte is always "STX" (02H). Bytes 2 to 192 are the measurement data for

the respective node, in the format shown in the table below. BCC is applied to this

section. The next 2 bytes are the BCC code in ASCII format which is calculated by

XOR processing of all 191 measurement data bytes. Finally, CR and LF (0x0a,

0x0d) are appended, resulting in a fixed-length frame of 196 bytes. This frame is

sent at intervals of at least 500 milliseconds. No response frame is required.
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4. Measurement data frame configuration (measurement data part)

Content Length Example Comments

Measurement point number 3byte 001 to 999 (3-digit ASCII) BCD (*1)

Group number 2byte 01 (2 ASCII characters; fixed to 01) BCD

Measurement point 4byte 4 ASCII characters Example: _P1

Measurement date 8byte 19970420 April 20, 1997

Measurement time 6byte 233456 23:34:56

Alarm status 1byte 0 or 1 0:N, 1:Y

Error status 1byte 0 or 1 or 2 1:Non-fatal, 2:Fatal

Error message 16byte Cell NG

CH 1 size 7byte 0.1um

CH 2 size 7byte 0.2um

CH 3 size 7byte 0.3um

CH 4 size 7byte 0.5um

CH 5 size 7byte 1um

CH 6 size 7byte 2um

CH 7 size 7byte 5um

CH 8 size 7byte Temp

CH 9 size 7byte Humid

CH 10 size 7byte

CH 1 measurement result (×100 value) 8byte 00000000 (8 hex digits) =0 (decimal measurement result)

CH 2 measurement result (×100 value) 8byte 12345678 (8 hex digits) =3054198.96

CH 3 measurement result (×100 value) 8byte 151F1C64  (8 hex digits) =3543604.2

CH 4 measurement result (×100 value) 8byte 0000A1DC (8 hex digits) =414.36

CH 5 measurement result (×100 value) 8byte 12F1E115 (8 hex digits) =3178416.85

CH 6 measurement result (×100 value) 8byte 00878F54 (8 hex digits) =88840.52

CH 7 measurement result (×100 value) 8byte 00B4168A (8 hex digits) =118022.5

CH 8 measurement result (×100 value) 8byte 9456D54C (8 hex digits) =-18062486.28

CH 9 measurement result (×100 value) 8byte FFFFFFFF (8 hex digits) =-0.01

CH 10 measurement result (×100 value) 8byte 7FFFFFFF (8 hex digits) =21474836.47

Measurement value is

multiplied by 100 and

converted into a 32-bit

integer  which is  ex-

pressed in ASCII format.

The RS-232C measurement data output format shown above applies to the condition when

"KF-02B" (10-channel) is selected (default condition).

(*1): The measurement point number is the same as the line position registered in the setup

window.

(RS-232C mode COM1 = measurement point number 1, multi-point mode (R).(M)

Node0 = measurement point number 1)
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18.2  Alarm Reset Output
1. Alarm reset output format

2. Alarm reset output timing

Output every time the alarm reset icon is clicked during measurement.

3. Other information

- Measurement data output has a different start delimiter SOH (01H) and no BCC.

- Character string length is fixed to 13 bytes.

- This output is used for resetting the optional alarm unit.

- The alarm reset output is sent only when the measurement data output format is

"KF-02B" (10-channel) (default condition).

18.3  RP Monitor Version and Alarm Unit Combination Table

The measurement data output format differs depending on the RP Monitor version. The table

below shows how alarm unit operation is affected by the different versions.

RP Monitor version Alarm unit version Operation Comments

2.A0 and later

3.A0 K9710 Ver3

4.A0

2.F0 and later

3.F0 K9710 Ver3

4.F0

K9710 Ver3

K0117 Ver1.3

Compatibility

A: No change required.

B: Make indicated change to enable use.

Compatibility: A

RS-232C measurement data output format was

developed for 6-channel.

Compatibility: A

Use RS-232C measurement data output format

"KF-02B" (10-channel). (This is the default.)

Alarm relay can be

reset by mouse op-

eration.

Compatibility: B

Change RS-232C measurement data output format

from "New" (8-channel) to "Old" (6-channel).

Compatibility: B

Change RS-232C measurement data output format

from "New" (8-channel) to "Old" (6-channel).

None

None

None2.G0 and later

3.G0

4.G0
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18.4  RP Monitor Measurement Data Output Change Method

1. Use Notepad to open the RP_MONI.INI file located in the folder where RP Monitor

is installed (for example RP_MONI.2G0).

2. The contents of RP_MONI.INI are shown, as below.

3. Change the RS-232C measurement data output format from KF-02B to "New" or

"Old".

4. Perform this procedure while RP Monitor is not running.
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19. Communication Logging

 1. From the menu, select [Options] → [Communication Logging].

When this option is checked, you can record information about the communication

between RP Monitor and particle counters in a log file. This is useful for example to

trace and identify causes of communication errors.

2. Communication history data can be recorded only in the modes listed below. In

other modes, the menu option does not appear.

RS-232C Mode

Multi Mode (R)

Multi Mode (M)
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20. Log Files

1. Operation history (RP_log.txt)
Records information about operation history.

2. Measurement communication history (XX_log.txt)
Records data sent and received via the serial port during measurement. The "XX" in the file

name stands for the file creation date. Consequently, one month's worth of files (most recent

month) can be recorded.

3. File size
The required amount of disk space for the measurement communication history log file is

about 15 megabytes for Period 60, 1 node, 1 month continuous measurement. Therefore, if

there are 20 nodes, 300 megabytes will be required for 1 month continuous measurement.

Because data older than 1 month will be subsequently overwritten, this figure represents the

upper limit.
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